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1 Einfdhrung

1.1 Wasist ein BPM Project?

Ein BPM(Business Project Management) Project ist eine Projektart innerhalb der X4 BPMS, mit der Sie
Geschaftsprozesse gemaB Notationsstandard BPMN 2.0 visualisieren und modellieren konnen. BPM
Projects enthalten eine vordefinierte Ordnerstruktur, in der beliebig viele Geschéaftsprozesse (BPM
Processes *.bpm)angelegt werden kénnen.

1.2 Wie kannich BPM Projects nutzen?

Im X4 Designer kdnnen Sie einen oder mehrere Geschéaftsprozesse (BPM Processes *.bpm)innerhalb
eines BPM Projects grafisch modellieren.

Der Geschaftsprozess kann mit unterschiedlichen Prozessbausteinen dargestellt werden. Diese
konnen per Drag&Drop in die Zeichnungsflache gezogen werden und mit Technical Processes
verknipft werden.

Bei komplexeren Unternehmensvorgangen lassen sich lbergreifende Geschaftsprozesse in einer
Prozesslandkarte (Dateiendung *.pld) orchestrieren und grafisch tbersichtlich visualisieren.
Prozesslandkarten dienen jedoch lediglich der Visualisierung und lassen sich nicht ausfiihren. Ein
BPM Project kann nur eine Prozesslandkarte, aber beliebig viele Business Processes

(*.bpm) enthalten.

Entscheidungsvorlage als Beispiel fiir einen Geschéaftsprozess

Entscheidungsvorlage / DecisionPaper

Antrag verarbeiten. Freigabe durch Freigabe durch Freigabe durch
BU benachrichten Leitar Geschiftsheraich, Gaschaftsfihrer, Betriebsrat.
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2

1

Oberflache

<

File Edit View Project Tools Window Help

P20~ o=
[P Projects 52 | 67 Apps = 0

Filter

= = 0

Meniileiste

Symbolleiste

Sichten

Perspektiven

Editoren und
Zeichnungsflache

Statusleiste

Uber die Mendileiste konnen Sie verschiedene Funktionen und
Editoren des X4 Designers aufrufen.

Uber die Symbolleiste kdnnen Sie verschiedene Funktionen und
Anzeigeoptionen aufrufen. Einige Symbole sind nur aktiv, wenn
die entsprechende Funktion fir das ausgewahlte oder gedffnete
Element verfligbar ist, siehe auch Symbolleiste.

Sie kdnnen die angezeigten Sichten per Drag&Drop individuell
anordnen.

Uber diese Symbole kénnen Sie zwischen den Perspektiven X4
Designer, Debug und BPMN Designer wechseln.

In diesem Bereich werden Prozesse und Dateien zum Anzeigen
und Bearbeiten in Registerkarten gedffnet.

In der Statusleiste werden der verbundene Server, der
angemeldete Benutzer und die Version der X4 BPMS angezeigt.
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2.

Symbolleiste

Uber die Symbolleiste kdnnen Sie verschiedene Funktionen und Anzeigeoptionen aufrufen. Einige
Symbole sind nur aktiv, wenn die entsprechende Funktion flir das ausgewahlte oder gedffnete
Element verflgbar ist.

C{’J

i

&2

Cd

I N

r&ll:_\_

Connect

Disconnect

New

Save

Save all

Repository Refresh

Attach/Detach Debug

Start Debugging

Undo

Redo

Cut

Copy

Paste

Start Debugging

Verbindung zum Server herstellen
Verbindung zum Server trennen

Neues Element hinzufligen

@ Welche Elemente Sie (iber dieses Symbol hinzufiigen kénnen,

hangt davon ab, in welcher Perspektive und an welcher Stelle der

Baumstruktur im Repository Sie sich befinden.

Anderungen im aktuell gedffneten Fenster speichern
Alle Anderungen speichern
Server-seitige Aktualisierung durchfiihren

Debugger mit der Server-Instanz verbinden/Debugger von der
Server-Instanz losen

Debugger starten

Letzten Bearbeitungsschritt rickgangig machen
Rickgangig gemachten Schritt wiederherstellen
Auswahl ausschneiden

Auswahl kopieren

Auswabhl einfigen

Optionen zur Prozessausflihrung aufrufen:

« Start Debugging: Prozess debuggen(Fehler anzeigen
und beseitigen)

« Start Without Debugging: Prozess direkt ausfihren

« Debug/Run Options: Run/Debug-Einstellungenim X4
Designer 6ffnen

© SoftProject GmbH
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Suspend
P Resume
B Stop Debugging

Step Into

Step Over

Step Return

@ Toggle Breakpoint

¥ Clear all Breakpoints

&d Quick Watch

(= Output
Q Zoomout

wx ~|Z00m

Zoom In

Snap to grid

Debugging anhalten
Debugging fortsetzen
Debugging beenden

Prozess-Schritt ausflihren (mit Anzeige der Schritte des
Subprozesses)

Prozess-Schritt ausfiihren (ohne Anzeige der Schritte des
Subprozesses)

Aus Subprozess herausspringen

Breakpoint (Debug-Haltepunkt)zu markiertem Baustein setzen
oder entfernen

Alle Breakpoints in diesem Prozess l6schen

Quick-Watch-Sicht 6ffnen, um Platzhalter, dynamische
Parameter und Kontextvariablen mit inren Werten wahrend des
Debuggens zu betrachten

Output-Sicht 6ffnen, um das Ergebnis jedes Prozess-Schrittes
wahrend des Debuggens zu betrachten

Ansicht verkleinern

Zoom-Stufe wahlen

Ansicht vergréBern

Raster einblenden und Bausteine am Raster ausrichten

(1) Show Process Quality Index  Process Quality Index einblenden

2.2 Kontextmenu

Kontextmenii flir Prozessbausteine

Wenn Sie im Editor-Bereich des X4 Designers mit der rechten Maustaste auf einen Prozessbaustein
klicken, stehen Ihnen je nach Bausteinart und Prozesstyp verschiedene Funktionen zur Verfligung:
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X4 BPM

Add Component
Layout

Select All

Copy Process Diagram to
Clipboard

Edit Label...
Undo...

Redo...
Copy
Cut

Set... document

Edit ...

Toggle Breakpoint
Delete

Validate
Preview

Show input schema
Show output schema
Select in Repository

Navigator
View Call Hierarchy
Refresh

Bring to Front

Neue Prozesskomponente hinzufligen
Ausgewahlte Prozesskomponenten ausrichten:

« Align Horizontal: Komponenten anhand des Mittelwertes

horizontal ausrichten

« Align Vertical: Komponenten anhand des Mittelwertes
vertikal ausrichten

« Distribute Horizontal: Komponenten gleichmaBig
horizontal verteilen

» Distribute Vertical: Komponenten gleichmaBig vertikal
verteilen

Alle Prozesskomponenten auswahlen
Prozessdiagramm zwischenspeichern

Namen der Prozesskomponente bearbeiten
Rickgangig machen

Letzten Schritt wiederherstellen
Markierten Prozessbaustein kopieren
Markierten Prozessbaustein ausschneiden

Markierten Baustein durch ein anderes Element im Repository
austauschen

Markierten Baustein/Datei bearbeiten (nur Modul-Bausteine und
Dokumente)

Debug-Haltepunkt setzen
Prozessbaustein aus dem Prozessdiagramm entfernen

Subprozess auf Gliltigkeit prifen (nur bei Subprozessen)

Prozessbaustein in separatem Editor 6ffnen (nur bei Modul-
Bausteinen und Dokumenten)

Input-Schema des Subprozesses anzeigen (falls vorhanden)
Output-Schema des Subprozesses anzeigen (falls vorhanden)
Prozessbaustein im Repository Navigator zeigen

Verwendungsnachweis flr den markierten Prozessbaustein anzeigen

Prozessbaustein neu aus dem Repository laden (nur bei Modul-
Bausteinen und Dokumenten)

Symbolin den Vordergrund des Diagramms setzen
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Bring Forward
Send Backward
Send to Back
Properties

Schema Declaration...

Symbol im Diagramm eine Ebene nach vorne setzen

Symbol im Diagramm eine Ebene nach hinten setzen

Symbolin den Hintergrund des Diagramms setzen

Eigenschaften des Prozessbausteins in der Properties-Sicht anzeigen

Schema-Deklaration fir den Prozess hinterlegen

Kontextmenti in der Projects-Sicht

Das Kontextmeni konnen Sie per Rechtsklick auf ein Element in der Projects-Sicht aufrufen.

New
Open/ Open With

Save As Template

Copy Full Path to Clipboard /

Copy XStore URL to
Clipboard

Cut, Copy und Paste
Delete

Rename/Refactor
Exclude from Project

Include to Project
Repair References
Validate

View Call Hierarchy
Start Without Debugging
Import

Export

Clean-Up Project

Neue Elemente (Prozesse, Ordner, Adapter etc.)im Repository
anlegen

Markiertes Element (Prozess, Ordner, Adapter etc.) mit dem
Standard-Editor oder einem bestimmten Editor 6ffnen

Markiertes Element als Vorlage speichern

Pfad zur markierten Datei in die Zwischenablage kopieren (als
Ordnerpfad oder als xstore://-URL)

Markiertes Elemente ausschneiden, kopieren oder einfligen

Markiertes Element aus dem Repository l6schen (der Léschvorgang
kann nicht riickgéngig gemacht werden)

Element (und falls gewlinscht dessen Referenzen) umbenennen
Ressource aus dem Projekt ausschlieBen

® . Die Datei wird im Dateisystem beibehalten, ist jedoch
nicht mehr Bestandteil des Projektes und wird ausgegraut
dargestellt. )
« Die Ublichen Operationen wie Offnen, Bearbeiten,
Kopieren, Loschen usw. konnen flr ausgeschlossene
Dateien nicht ausgefihrt werden.

Ausgeschlossene Ressource wieder in das Projekt aufnehmen

Pfade von Repository-Ressourcen in Prozessdiagrammen reparieren
Prozess auf Glltigkeit prifen

Anzeigen, in welchen Prozessen dieses Element verwendet wird
Prozess direkt ausfihren

Ressource ins Repository importieren

Projekt oder Ressource exportieren

Nicht verwendete Dateien auswahlen und aus dem Repository
|6schen

© SoftProject GmbH 1
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2.5  Perspektiven

Eine Perspektive ist eine festgelegte Anordnung von Sichten und dem Editorbereich. Sie kdnnen per
Drag&Drop individuell anordnen.

= X4 Designer Die X4 Designer-Perspektive ist die Standardansicht.

= Debug Die Debug-Perspektive ist eine optimierte Ansicht flir das Debugging von
Geschaftsprozessen und technischen Prozessen.

< BPMN Die BPMN Designer-Perspektive ist eine optimierte Ansicht fiir die Modellierung von
Designer Geschaftsprozessen.

2.3.1 Perspektive wechseln

Im X4 Designer kdnnen Sie zwischen Perspektiven wechseln. Die Anordnung der Sichten bleibt dabei
erhalten.

« Um die Perspektive zu wechseln, klicken Sie im oberen rechten Bildschirmbereich auf das
Symbol der gewlinschten Perspektive.

2.3.2  Perspektive zuricksetzen

Um eine Perspektive zuriickzusetzen, gehen Sie wie folgt vor:

1. Wechseln Sie in die Perspektive.
2. Wahlen Sie in der Mentileiste Window > Reset Window Layout.

2.4  Sichten

= Projects In der Sicht Projects wird eine Baumstruktur des verbundenen Repositorys mit
verschiedenen Elementen wie Projekten, Ordnern und Dateien angezeigt. Sie kdnnen
das Kontextmenu aufrufen, indem Sie mit der rechten Maustaste auf ein Element
klicken. Abhangig davon, an welcher Stelle in der Baumstruktur Sie sich befinden,
andern sich die Optionen im Kontextmendi.

Uber das Textfeld Filter (iber dem Projektbaum kdnnen Sie nach Dateien innerhalb
des verbundenen Repositorys suchen. Platzhalter wie x oder ? sind nicht moglich.

Uber die Symbolleiste der Sicht Projects konnen Sie die folgenden Aktionen
ausfihren:

. 8 Jump from active Editor to Repository Navigator: Gedffnete Datei im Editor
im Repository Navigator markieren

. 3 Show or hide all files: Inhalt des Dateisystems einblenden und ausblenden.
Aus dem Projekt ausgeschlossene Dateien werden dabei ausgegraut dargestellt.

© SoftProject GmbH 12
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@ Apps

= Properties

In der Sicht Apps werden alle X4 Apps angezeigt, die zum Blndeln von Projekten
verwendet werden.

In der Sicht Properties kdnnen Sie die Eigenschaften von markierten

Prozessbausteinen und gedffneten Prozessen anzeigen und bearbeiten.

« Inderlinken Spalte befinden sich die Eigenschaften, in der rechten Spalte die
zugehorigen Werte.

« Flrjeden Prozess kann ein Titel sowie eine Beschreibung hinterlegt werden.
Diese Angaben werden in der erzeugten Dokumentation angezeigt.

« Um die Eigenschaften eines gedffneten Prozesses zu bearbeiten, klicken Sie auf
einen leeren Bereich auf der Zeichnungsflache.

] Properties &3 2 = =0
Property Value
Business Data [Electronic Invoice, Invoic...
Can Stop 4
Case W
Case States [Invoice is imported, To b...
Created 14, 2, 2019 08:12:44
Created By ErigitteStall
Free-flow mode
In zervice 2
Instance limit 0
Last Update 19, 8, 2019 (& 16:52
Last Update By BrigitteStall
Schedule Dizabled
Stop on error 7
Title Approval of electronic inv...
Version 1566195411731

StandardmaBig werden die gebrauchlichsten Eigenschaften angezeigt. Uber die
Symbolleiste der Sicht Properties kdnnen Sie jedoch zusatzliche Einstellungen

vornehmen:

®

I

Pin to Selection: Angezeigte Eigenschaften in der Sicht Properties anheften

. 5 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen
. 3P Show Advanced Properties: Erweiterte Eigenschaften anzeigen
. Restore Default Value: Auf Standardwerte zurlicksetzen

- 7 View Menu: Zusatzoptionen 6ffnen

© SoftProject GmbH 13
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» Run/Debug Wird ein Prozess auf Fehler Uberprift bzw. simuliert, werden in der Sicht Run/Debug

Console

Console zu jedem ausgefihrten Prozess-Schritt Debug-Informationen angezeigt.
Fehlermeldungen werden rot hervorgehoben, erfolgreiche Statusmeldungen grin.

Wenn ein Prozess-Schritt ein Zwischenergebnis ausqgibt, wird dieses wahrend des
Debuggens in einer temporaren Datei gespeichert, die Sie Gber den entsprechenden
Verweis ansehen kénnen(z. B. file://1376054979039/).

@ Sie kdnnen die Sicht Run/Debug Console iiber das Menii View > Run/Debug
Console aufrufen.

© SoftProject GmbH 14
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@ Output
einsehen.

@ Sie kdnnen die Sicht Output wahrend des Debuggens iiber das Menii Debug >

In der Sicht Output kdnnen Sie die Ergebnisse jedes einzelnen Debug-Schritts

Output oder tGber das Symbol Output & inder Symbolleiste aufrufen.

& Importinvoice.wrf

Import electronic invoice

4

o=

Start Invoce

=
2
Import

electronic
nvoice

(= Output » bd Quick Watch) P Run/Debug Console
Encoding: UTF-8 MIME-Type: text/xml

<fxml version="1.8" encoding="UTF-8"¢>»

<Receiver>

<Name>SoftProject GmbH</Name>
<VatId>DE12345678</VatId>
<Street>Am Erlengraben 3</Street>
<ZipCode>76275</ZipCode>
<City>Ettlingen</City

ty
<Country>DE</Countrys

c R >y -
</Receiver>

(= Qutput =  Bd Quick Watch | B Run/Debug Console

O

Save features Stop

The current output contains large amount of data (9,97 ME).

Opening large amounts of data can adversely affect the performance of the X4 Designer.
If the data could not be displayed, please increase the memory used by X4 Designer.

To load the data, press the "Load™ button.

i1 Load

& Wenn die ausgegebenen Daten gréBer als 1MB sind, wird eine Warnung
angezeigt. Sie konnen die Daten Uber eine Schaltflache herunterladen.
GroBe Datenmengen konnen die Performance des X4 Designers

beeintrachtigen.

Uber die Symbolleiste kdnnen Sie auBerdem die folgenden Aktionen ausfiihren:

. [ Find content: Daten in der Sicht Output finden
. Copy all content: Alle Daten in der Sicht Output in die Zwischenablage

kopieren

. B Copy selected content: Ausgewahlte Daten aus der Sicht Output in die

Zwischenablage kopieren

. B Save content: Daten aus der Sicht Output speichern

. 2 Format content: Daten aus der Sicht Output formatieren

A Hinweis

© SoftProject GmbH

RpBAR=O

-

E

15



X4 BPM

= X4 Server
Log

= Call
Hierarchy

Binare Daten werden in der Sicht Output als hexadezimale Daten
ausgegeben. Bilder und textbasierte Inhalte werden als Bild bzw. Text
ausgegeben. Durch die Ausgabe binarer Daten als hexadezimale Daten wird
die Performance des X4 Designers nicht beeintrachtigt.

In der Sicht X4 Server Log kdnnen Sie den Server-Status und insbesondere Fehler im

X4-Server-Log aus dem X4 Designer heraus verfolgen.
P, Run/Debug Conscle | [E] ¥4 Server Log &1 | |2 Call Hierarchy = B

2019-08-28 12:55:33.135 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Finis
2019-08-28 12:55:33.136 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Proc
2019-08-28 12:55:33.145 ERROR [de.softproject.integration.engine.X4engine] (default task-2) Mo
2019-08-28 12:55:33.146 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Finis
2019-08-28 12:55:33.163 INFO [de.softproject.integration.engine.debug.impl 5ession] (default ta

< >

@ Sie kdnnen die Sicht X4 Server Log (iber das Menii View > X4 Server Log aufrufen.

In der Sicht Call Hierarchy konnen Sie flr jeden Prozess und Prozessbaustein im
Repository anzeigen, von welchen Repository-Elementen diese verwendet werden.

hRun,-"DEbug Console [E] ¥4 Server Log | 3= Call Hierarchy 53 = O

v g BPMProject_2/Processes/Activities/Processes/Approvefutomatically.wrf
[a] BPMProject_2/Processes/Invoicefipproval.bpm

Wenn Sie mit der rechten Maustaste auf ein Element im Repository Navigator
klicken, wird ein Kontextmeni aufgerufen. Mit View Call Hierarchy wird
anschlieBend eine Auflistung aller Repository-Elemente angezeigt, die mindestens
eine Referenz auf das markierte Element enthalten.
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@ Error Log Inder Sicht Error Log kdnnen Sie im X4 Designer aufgetretene Fehler einsehen.

h Run/Debug Conscle [E] X4 Server Log 3*0 Call Hierarchy | € Error Log 53
Workspace Log

ftyp 1

Message Plug-in

v (& Warnings while parsing the key bindings from the org.eclipse.ui
!, Cannot bind te an undefined command: plug- org.eclipse.ui

€3 Cannet convert null to a primitive org.eclipse.core.databind...
€3] Cannot convert null to a primitive arg.eclipse.core.databind...
€3 Cannot convert null to a primitive arg.eclipse.core.databind...

w (& Warnings while parsing the key bindings from the org.eclipse.ui
I, Cannot bind to an undefined command: plug- org.eclipse.ui

Date

28.08.19, 10:03
28.08.19, 10:03
19.08.19, 08:16
19.08.19, 0815
19.08.19, 08:07
19.08.19, 08:04
19.08.19, 08:04

s =3 e m o= =
=l - x X 5 ZF
B X e

i

V= H

Uber die Symbolleiste kdnnen Sie auBerdem die folgenden Aktionen ausfiihren:

. . Import Log: Error Log(. log)importieren
. ® Clear Log Viewer: Error Log bereinigen

. R Delete Log: Error Log unwiderruflich 1dschen

. = Open Log: Log-Datei(.log)im X4 Designer 6ffnen

. 7 Restore Log: Error Log wiederherstellen
« 7 View Menu: Zusatzoptionen 6ffnen

= Export Log: Error Log exportieren und als . log-Datei speichern

@ Sie konnen die Sicht Error Log (iber das Men(i View > Error Log aufrufen.

@ Problems Inder Sicht Problems werden alle Fehler und Warnungen aufgelistet. Sie kdnnen die

Liste der Probleme Uber das Filtersymbol anpassen.

% Debug In der Sicht Debug Sessions werden alle aktiven Debug-Sessions aufgelistet. Indem
Sessions  Siein der Sicht Debug Sessions auf einen Prozess doppelklicken, wechseln Sie in die

zugehorige Debug-Session.

Aktive Debug-Sessions sind grau markiert. Mit dem Server verbundene, neue Debug-

Sessions sind orange markiert.

. Breakpoint In der Sicht Breakpoints werden alle gesetzten Breakspoints aufgelistet. Sie konnen
S Breakpoints aktivieren, deaktivieren und l6schen. AuBerdem kdnnen Sie alle
Breakpoints tberspringen, ohne die Breakpoints zu l6schen.
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63 Quick
Watch

= Outline

» Baseb4
» Digest

» Regex

In der Sicht Quick Watch kdnnen Sie Variablen, Parameter und dynamische
Parameter mit ihren Werten wahrend des Debuggens getrennt voneinander
betrachten.

Dazu wahlen Sie in der Dropdown-Liste den entsprechenden Eintrag aus:

(= Output |6d Quick Watch > | P» Run/Debug Console

Variables ~

Parameters

Dynamic Parameters

Ausgewahlte Variablen werden nach jedem Debug-Schritt aktualisiert.

Wenn Sie den Eintrag Parameters auswahlen, kénnen Sie Uber die Kontrollkastchen
Project, Global und System festlegen, welche Parameter Sie anzeigen mochten:

(= Output |bd Quick Watch > | P Run/Debug Console

Parameters w Project @ Global B System

& Enthélt das Ergebnis Inhalte, die groBer als 1MB sind, wird eine Warnung
angezeigt, und Sie kdnnen das Ergebnis Uber eine Schaltflache
herunterladen.

GroBe Datenmengen kdnnen sich negativ auf die Leistungsfahigkeit des X4
Designers auswirken.

@ Sie kdnnen die Sicht Quick Watch wahrend des Debuggens {iber das Menii Debug >
Quick Watch oder Gber das Quick-Watch-Symbol 6d in der Symbolleiste aufrufen.

In der Sicht Outline wird das vollstandige Prozessdiagramm als Abbildung angezeigt.
Sie kdnnen auf einzelne Bereiche in der Abbildung klicken und so mihelos durch den
Prozess navigieren, selbst wenn die Abbildung groBer ist als das Designer-Fenster.

@ Sie kdnnen die Sicht Outline Giber das Menii View > Outline aufrufen.
Zeichenketten Base64-kodieren oder dekodieren

Hash-Wert fur Zeichenketten erzeugen

Regularen Ausdruck (Regex) auf eine Zeichenkette anwenden, um den Ausdruck zu

testen oder um die Zeichenkette gemaR einem Muster direkt zu ersetzen
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# URLCodec Zeichenketten URL-kodieren oder dekodieren

2.4.1 Sichten offnen

& |n der Perspektive BPMN Designer kdnnen keine weiteren Sichten gedffnet werden, da alle
relevanten Sichten standardmaBig gedffnet sind.

« Wahlen Sie in der Menlleiste im Menl View die gewiinschte Sicht.

2.5 Editoren

Im X4 Designer werden Prozesse und Dateien zum Anzeigen und Bearbeiten in Registerkarten
gedffnet. Der verwendete Editor ist abhangig vom gedffneten Dateityp.

Editor
BPMN Editor

Datenbank-Editor

JSON Editor

Mapping Editor

Parameter-Editor

Process Editor

XML Editor

Verwendung
.bpm

.pld

.stm

.json

Xsl

.rep

.param

.wrf

xml

xhtml

Beschreibung

Mit dem BPMN Editor konnen Sie
Geschaftsprozesse gemal dem
Notationsstandard BPMN 2.0 modellieren.

Mit dem Datenbank-Editor konnen Sie SOQL-
Abfragen fir Bausteine einer
Datenbankverbindung definieren, um Daten aus
einer relationalen Datenbank abzufragen.

Mit dem JSON Editor konnen Sie JSON-
Dokumente direkt im X4 Designer bearbeiten.

Mit dem Mapping Editor konnen Sie XSL-
Mappings in einer grafischen Ansicht erstellen
und bearbeiten.

Mit dem Parameter-Editor kdnnen Sie Projekt-
Parameter und Projekt-Parameter-Gruppen
erstellen, um Prozessbausteine zu
parametrieren.

Mit dem Process Editor konnen Sie technische
Prozesse grafisch modellieren.

Mit dem XML Editor kdnnen Sie wohlgeformte
XML-Dokumente erstellen und bearbeiten.
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XSD Editor .xsd Mit dem XSD-Editor konnen Sie eine XML-
Schemadefinition fir lhre XML-Dokumente
erstellen.

2.5.1  BPMN Editor

Mit dem BPMN Editor kdnnen Sie Geschaftsprozesse gemaB dem Notationsstandard BPMN

2.0 modellieren. Der Editor entspricht in Aufbau und Bedienweise in weiten Teilen dem Process
Editorim X4 Designer, unterscheidet sich jedoch im Hinblick auf die Prozessbausteine und Symbole
im Prozessdiagramm. Mit dem BPMN Editor werden die modellierten Geschaftsprozesse direkt mit
den technischen Prozessen verknupft. Das heiBt: Sie kdnnen Ihre fachlichen und technischen
Prozesse modellieren und liber den X4 Server testen und ausfiihren, ohne die Entwicklungsumgebung
zu wechseln.

Da auch nicht-automatisierbare Aktionen - etwa Arbeitsabldufe von Menschen -in
Geschaftsprozesse eingebunden werden kénnen, lassen sich Geschaftsprozesse nicht
notwendigerweise auf dem X4 Server ausfihren.

@ Im Free-flow-Modus besteht zusétzlich die Mdéglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterte BPMN-Palette zu verwenden, bei der die Funktion Run/
Debug deaktiviert ist.

2.5.2 Datenbank-Editor

Mit dem Datenbank-Editor kdnnen Sie SQOL-Abfragen flir Bausteine einer Datenbankverbindung
definieren, um Daten aus einer relationalen Datenbank abzufragen. Durch die logische Trennung der
Prozessbausteine SOL-Anweisungund Datenbankverbindunglassen sich diese Prozessbausteine
im X4 Designer flexibel einsetzen und mehrfach verwenden.

® Um den Datenbank-Editor aufzurufen, legen Sie eine neue SQL-Statement-Datei(.stm)an,
oder 6ffnen Sie eine bereits vorhandene SQL-Statement-Datei.

Aufbau des Datenbank-Editors

Der Datenbank-Editor besteht aus den folgenden Bereichen:

» Statement Editor: In diesem Bereich kénnen Sie eine Verbindung zu einer Datenbank aufbauen
und die Struktur der verbundenen Datenbank anzeigen. Mit dieser Struktur kdnnen
anschlieBend SQL-Statements fur die Datenbank erstellt werden.

» Mapping Editor: In diesem Bereich kdnnen Sie flr das im Statement Editor zuvor erstellte
Statement ein Mapping von Elementen eines Input-XML-Dokuments auf die Named Parameter
des Statements definieren. Aus diesem Mapping kdnnen Sie anschlieBend ein XSL-Mapping
erstellen, das mit einem passenden Input-XML-Dokument eine dynamisch erzeugte Eingabe flr
den JDBC Connector erzeugt.
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Connection

JDBC Connector: | xstore;/Documentation_6.0/Adapters ~ | Connect.. Status: Connected tojava;/X4BAM_DS Execute Statement...
Database Statement
~ [& INFORMATION_SCHEMA ~ v Statements Root
F CATALOGS ~ Named Prepared Statement
E COLLATIONS Resulttag result
B COLUMNS Time Zone GMT
E COLUMN_PRIVILEGES Date Format
B CONSTANTS ~ INSERT
[ CONSTRAINTS INTO PUBLIC.CUSTOMERS (ADDRESS, CITY, COMPANYNAME, COUNTRY, CUSTOMER..
B CROSS_REFERENCES VALUES
B DOMAINS ~ RowSet
B FUNCTION_ALIASES v Row
EE FUNCTION_COLUMNS address
& HELP city
B INDEXES companyName
E IN_DOUBT country
B LOCKS customerlD
[ QUERY_STATISTICS phone
B RIGHTS postalCode
& ROLES e

Statement Editor| Mapping Editor

2.5.2.1 Statement Editor

Der Statement Editorist in folgende Bereiche unterteilt:

Connec Indiesem Bereich kdnnen Sie Uber einen JOBC Connectoreine Verbindung zu einer
tion- Datenbank aufbauen.
Bereich

« JDBC Connector: xstore-URL zu einem JDBC Connector

® « Um eine Verbindung aufbauen zu kdnnen, muss der Adapter innerhalb des
Parameters JndiName einen glltigen JNDI-Namen enthalten.
« Inder Dropdown-Liste werden die letzten acht verbundenen URLs zur
Auswahl angeboten.

» Connect: Mit der Datenbank verbinden
Unter Status wird der Verbindungstatus angezeigt.

- Execute Statement: Statement ausfihren

Databa Indiesem Bereich wird nach dem Verbindungsaufbau die Struktur der Datenbank
se- angezeigt. Fur die Darstellung der Struktur werden die folgenden Symbole verwendet:
Bereich

. & Datenbankschema

. B Datenbanktabelle

. Primarschlissel

« o= Primarschlissel/Fremdschlissel
« &= Fremdschlissel
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Statem
ent-
Bereich

In diesem Bereich kdnnen Sie Uber das Kontextmeni verschiedene Statements fur die
verbundene Datenbank anlegen:

New Named Prepared Statement: Im Statements Root ein neues Named Prepared
Statement anlegen

Edit Named Prepared Statement: Named Prepared Statement bearbeiten

New RowSet: Neues RowSet anlegen.

@ Innerhalb eines Named Prepared Statement kann lediglich ein RowSet existieren.
Dieses wird beim Anlegen des Named Prepared Statement automatisch mit angelegt.
Ein neues RowSet kann nur angelegt werden, wenn das bestehende RowSet geldscht
wurde.

New Row: Neue Zeile innerhalb eines RowSet hinzufligen

New Named Parameter Value: Einen neuen Named Parameter-Wert innerhalb einer
Zeile hinzuflgen

Edit Named Parameter: Named Parameter bearbeiten

New SELECT Statement: Ein neues SELECT-Statement anlegen

Edit SELECT: SELECT-Befehl bearbeiten

Edit FROM: FROM-Befehl innerhalb eines SELECT-Statements bearbeiten

New INSERT Statement: Ein neues INSERT-Statement anlegen

Edit INTO: INTO-Befehl bearbeiten

New VALUE Entry: Neuen Eintrag unter VALUE anlegen

Edit VALUE: Wert eines VALUE-Eintrags bearbeiten

New UPDATE Statement: Ein neues UPDATE-Statement anlegen

Edit UPDATE: UPDATE-Befehl bearbeiten

New SET Entry: Neuen Eintrag unter SET anlegen

Edit SET Entry: Eintrag unter SET bearbeiten

New DELETE Statement: Ein neues DELETE-Statement anlegen

Edit FROM: FROM-Befehl bearbeiten

Edit WHERE: WHERE-Bedingung bearbeiten

New Column: Neue Spalte innerhalb eines INSERT- oder SELECT-Befehls einfligen
New Table: Neue Tabelle innerhalb eines UPDATE- oder SELECT-Befehls einfligen

Delete: Element I0schen

@ Weitere Informationen zum Anlegen und Bearbeiten von Statements finden Sie im

Abschnitt Statement fir eine verbundene Datenbank erstellen.

Drag&Drop-Aktionen

Im Statement-Bereich kdnnen Sie die folgenden Drag&Drop-Aktionen ausfihren:
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25.2.2

SQL-
Statement

SELECT

UPDATE

INSERT

DELETE

Datenbank-
Element

Column

Table

Column

Table
Table

Column

Table

Mapping Editor

Statement-
Element

SELECT

FROM

SET Entry

UPDATE
INTO

INTO

FROM

Aktion

Die auszuwahlende Spalte hinzufligen

© stent die Tabelle der Spalte noch
nicht im FROM, wird diese hinzugefligt.

Tabelle hinzuflgen, aus der ausgewahlt
werden soll

Spalte als Eintrag setzen

© stent die Tabelle der
entsprechenden Spalte noch nicht im u
PDATE, wird diese hinzugeflgt.

Die zu aktualisierende Tabelle setzen

Tabelle setzen, in die geschrieben
werden soll

ﬂ Ist bereits eine Tabelle vorhanden,
wird diese ersetzt. Dabei werden auch
bereits gesetzte Spalten(Columns)
geldscht.

Spalte setzen, in die geschrieben
werden soll

O Diesist nur maoglich, wenn die
Spalte aus der gesetzten Tabelle
stammt.

Die zu loschende Tabelle setzen

'ﬂ' Ist bereits eine Tabelle vorhanden,
wird diese ersetzt.

Mit dem Mapping Editor konnen Sie fur die zuvor im Statement Editor angelegten Statements per
Drag&Dropp Mappings von einem Input-XML-Dokument auf die Named Parameters der Statements
konfigurieren und anschlieBend erstellen. Diese Mappings erzeugen mit einem passenden Input-XML-
Dokument eine dynamisch erzeugte Eingabe fir den JOBC Connector.

Der Mapping Editor ist in folgende Bereiche unterteilt:

© SoftProject GmbH 23



X4 BPM

Generate mapping

~ [e] Customers v [e] statements
~ [&] Customer adapterPath="xstore:;/Documentation_6.0/Adapters/JDBC_Connector_1.fa"
id="777" mappinglnput="xstore:/X4Experience/ESB/3-Reference/3-Features/DatabaseEditor/Data/exampleCustomer.xml”
[e] Name N ~ [e] namedpreparedstatement
~ [&] Anschrift \‘\\ resulttag="result"
[e] Adresse N timezone="GMT"
[e] Stadt (2] sql
[l PLZ ~ [&] rowset
[l Land ~ [& row
[e] Telefonnummer [el address
[&] city
[e] companyName
[e] country
[el customerlD
(€] phone
[e] postalCode

Statement Editor Mapping Editor

Quelldok Auf der linken Seite befindet sich in der Quelldokument-Bereich. In diesem Bereich
ument- konnen Sie die Input-XML-Datei per Drag&Drop ablegen und anzeigen.
Bereich

Uber das Kontextmenii kénnen Sie den gewahlten Knoten wie folgt bearbeiten:

» Collapse: Knoten mit aufgeklappten Unterelementen zuklappen
« Expand: Unterelemente des Knotens aufklappen
+ Remove Input: Input-XML-Dokument entfernen

Verkniip In der mittleren Spalte befindet sich der Verknipfungsbereich. In diesem Bereich werden
fungsbe die xs1:value-of-Verknipfungenzwischen dem Element aus dem Quelldokument und
reich dem Named Parameter im Statement als Linien visualisiert.

Stateme Auf derrechten Seite befindet sich der Statements-Bereich. In diesem Bereich wird die
nts- gesamte Struktur der Statement-Datei angezeigt. Dabei kdnnen Mappings vom Input-XML
Bereich auf die Kind-Elemente eines Row-Elements erstellt werden.

2.5.3  JSON Editor
Mit dem JSON Editor kdnnen Sie JSON-Dokumente direkt im X4 Designer bearbeiten.

® Um den JSON Editor zu starten, legen Sie entweder ein neues JSON-Dokument an oder
offnen ein bereits vorhandenes Dokument.

In der Sicht Outline wird die Struktur des gedffneten JSON-Dokuments angezeigt. Zudem konnen Sie
Uber das KontextmenU Quick Outline oder Uber die Tastenkombination STRG+0 die Sicht Quick Outline
offnen, um innerhalb des JSON-Dokuments nach Schlisseln und Werten zu suchen.

Tastenkombinationen

STRG+0 Sicht Quick Outline 6ffnen
STRG+Umschalttaste+F JSON-Code formatieren
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T text_1json 52

"para®: "

"GlossSeeAl

I
"GlossSee":

mal

~ L} Object ~
~ {} "glossary"
5 "fitle”; "example glossary”
~ {} "GlossDiv"
5 “title": "S"
~ {3} "GlossList”
~ {} "GlossEntry"
S "ID": "SGML"
5 "SortAs" "SGML"
5 "GlossTerm": "Standard General
5 "Acronym": "SGML"
S "Abbrev": "ISO 8879:1986"
w {7} "GlossDef"
5 "para’: "A meta-markup lani
v

w I'1 "GlossSephlsn”
< >

Regular expressions enabled|

languages such as DocBook.”,

O= Outline 32

~ {} Object
« £} "glossary”

S 'title": "example glossary"
~ {} "GlossDiv"
S “title”: S
w {} "GlossList”
w {} "GlossEntry"

L

5

“ID": "SGML"

"Sarths": "SGML"

"GlossTerm": "Standard Generalized Markup Language”
"Acronym": "SGML"

"Abbrey": "IS0 8379:1936"

{} "GlossDef"

5

"GlossSee": "markup”

@ Die Formatierung des JSON-Codes sowie die Farben zur Syntaxhervorhebung kdnnen Sie
unter Tools > Options > JSON Editor andern. Siehe auch JSON-Editor konfigurieren.

2.5.4

Mapping Editor

Mit dem Mapping Editor kénnen Sie XSL-Mappings in einer grafischen Ansicht erstellen und
bearbeiten. Eine XML-Datenstruktur kann hier mithilfe von XSLT in eine andere XML-Datenstruktur
oder in ein XSL-FO-Dokument transformiert werden. Der Mapping Editor unterstitzt Sie beim
Erstellen eines XSL-Mappings durch eine grafische Oberflache und durch eine automatische

Glltigkeitsprifung des Stylesheets sowie der XPath-Ausdricke.

Bei einem XSL-Mapping sind drei Dokumente involviert:

« XML-Quelldokument (oder ein XML-Schema mit der Strukturinformation)

« XSLT-Stylesheet (dieses wird im Mapping Editor erstellt)

« XML-Ausgabedokument

® Um den Mapping Editor zu starten, legen Sie entweder ein neues Mapping an oder 6ffnen ein
bereits vorhandenes XSLT-Mapping.

Aufbau des Mapping Editors

Der Mapping Editor ist in folgende Bereiche unterteilt:
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¥4 Designer - /ESBProject_1/Transformations/1/XSLMapping sl - XSLMappingaxs!

| File Edit View Project Tools Run Window Help
i Ak o
= Projects x | gR= 8
Filter
| [ [ EsBproject_1
> & Adapters
> & Processes

> & Resources
> & TemporaryFiles
> & Transformations

|| > ® X4Common (Libra

[ Properties x

Property Value

1 Quelldokument-Bereich

2  Verkniipfungsbereich

- o x
Q | u[& O
% XSLMappinguxsl X =n
« [ Data ~ B stylesheet version="1.0"
~ [&] CUSTOMERS Xminsaxsl="httpy//www.w3.0rg/1999/XSL/Transform"
sl CUSTOMERID =% output method ="html” media-type="text/ntmi"
5 COMPANYNAME —————————— 5~ & template match="/"
[& ADDRESS . v & htmi
moy ————— N\ @ xmins="httpy//www.w3.0rg/1999/xhtmI"
& POSTALCODE NN « [ head
5] COUNTRY NN v (@ title
sl PHONE AN \\ T "Customers”
\\ N « & body
N @ style="font-familyCalibri, sans-serif"
N 5 « "8 for-each select="/Data/CUSTOMERS"
O\ v @ div
N v @
N e \alueof select="COMPANYNAME"
AN v Ep
e ¥ value-of select="CITY"
v Ep
@ style="text-alignright"
T “(c) SoftProject GmbH"
£~ Created by X4 Designer 42, Copyright..
| Design| source| .
[ Output X |6d Quick Watch| > Run/Debug Console REBAR =0

Encoding: UTF-8 MIME-Type: text/xml
<?xml version="1.8" encoding="I150-8859-1"?>
<Data> I
<CUSTOMERS >
<CUSTOMERID>1@1</CUSTOMERID>
<COMPANYNAME>SoftProject GmbH
</COMPANYNAME>

<ADDRESS>Am Erlengraben 3</ADDRESS>

<CITY>Ettlingen</CITY>

<POSTALCODE>76275¢</POSTALCODE>

Connected to: X4 Server (localhost:8080) | Workspace: 1 | Username: demo | X4 Server 7.3.1-SNAPSHOT

In diesem Bereich wird das zu transformierende Quelldokument
oder eine XML-Schema-Datei (. xsd)angezeigt.

Uber das Kontextmenii kdnnen Sie den gewahlten Knoten wie
folgt bearbeiten:

Copy XPath for this element to Clipboard: XPath-

Ausdruck zum entsprechenden Element in die
Zwischenablage kopieren und an anderer
Stelle verwenden
« Assign Input: Input-XML-Dokument zuweisen
« Remove Input: Input-XML-Dokument entfernen
« Paste Input: Input-XML-Dokument aus der

Zwischenablage einfligen

In diesem Bereich werden die Verknlpfungen zwischen Knoten
im Quelldokument und XSL-Stylesheet als verschiedenfarbige
Linien visualisiert.

® Unter Tastenkombinationen im Mapping Editor finden
Sie nutzliche Tastenkombinationen fir die Arbeit mit
XSL-Stylesheets in der grafischen Ansicht des X4
Mapping Editors.
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3

Stylesheet-Bereich

In diesem Bereich bearbeiten Sie den Hauptbestandteil eines
Mappings, das XSL-Stylesheet. Das Stylesheet wird in einer
Baumstruktur angezeigt und bietet Gber das Kontextmen
Zusatzfunktionen fur die XSL-Bearbeitung.

Die verschiedenen Bestandteile des XSL-Stylesheets werdenin
der Baumansicht mit Symbolen und farblichen Hervorhebungen
dargestellt:

« Knoten mit XSL-Anweisungen sind durch eine braune
Schriftfarbe und ein entsprechendes Symbol
gekennzeichnet, z. B. H*E*L for-each select="0atajCustomers" )

« Knoten mit einem XPath-Ausdruck sind durch ein
entsprechendes XPath-Symbol ( =) gekennzeichnet. Um den
XPath-Ausdruck zu bearbeiten, klicken Sie auf dieses
Symbol.

« Virtuelle Knoten (aus der Quellstruktur Gbernommene, aber
noch nicht im Stylesheet explizit vorhandene Knoten) werden
grau dargestellt.

Uber das Kontextmenii kdnnen Sie im Stylesheet-Bereich den
gewahlten Knoten wie folgt bearbeiten:

« Edit XSL Element: XSL-Element bearbeiten
+ Rename: Knoten umbenennen
« Element: Element einfligen
« Attribute: Attribut einfligen
- Edit: (bei Processing Instructions, Namespace-
Deklarationen): Knoteninhalt bearbeiten
+ XSL Element: XSL-Element einfligen
« as Child: als Kind-Knoten
» Before: als Knoten vor dem markierten Knoten
« After: als Knoten hinter dem markierten Knoten
- Add other nodes: andere Knoten einfligen (Namespace, Text,
Comment, Processing Instruction)
« Add here: (nur bei virtuellen Knoten): virtuellen Knoten in
tatsachlichen Knoten umwandeln
« Add Processing Instructions: Processing Instructions
hinzufligen, um Parameter dynamisch zu setzen
+ Condition State flr Statusinformationen
« Log Info flrLog-Nachrichten
« Dynamic Parameter zum Setzen von dynamischen
Werten
« No Result furleere Mapping-Ausgaben
« Add Parameter: System-, Projekt- oder
globale Parameter einfligen, siehe Parameter erstellen und
verwenden
« Add Parent: Eltern-Element (ibergeordnetes Element)
einfligen
« Cut/Copy/Paste: Auswahl ausschneiden, kopieren und
einflgen
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4

5

 Delete: Knoten l6schen

« Expand/Collapse: Unterelemente des Knotens aufklappen
bzw. zuklappen

« Assign Virtual Nodes: virtuellen Knoten aus einem XML-
Dokument einfligen

« Remove Virtual Node: eingefiigten virtuellen Knoten
entfernen

@ Mit dem XSL Element Creation Wizard kdnnen Sie
einfach und schnell XSL-Mappings erstellen. Der Wizard
bietet neben der kompletten Palette an XSLT 2.0-
Elementen auch die Maglichkeit, die Mappings
bequem Uber das Kontextmenu anzulegen.

Uber den Wizard lasst sich festlegen, ob das neue
Element vor oder nach dem ausgewahlten Element oder
als Kind des ausgewahlten Elements angelegt werden
soll. Funktionen wie Autovervollstandigung oder die
Anzeige aller verfligbaren und erlaubten XSL-Elemente
ermoglichen schnelleres Arbeiten.

Zudem kdnnen die Attribute des XSL-Elements gesetzt
bzw. nach dem Anlegen bearbeitet werden. Zwingend
erforderliche Attribute werden dabei automatisch
Ubernommen, optionale Attribute konnen je nach Bedarf
ausgewahlt und befllt werden.

Bei Attributen, die mehrere Optionen zur Auswahl haben,
wird eine Liste mit den verfligbaren

Werten bereitgestellt.

Source- und Design-Ansicht Der Mapping Editor verfligt iber zwei Ansichten, zwischen denen

Output

Sie Uber zwei Registerkarten wechseln kénnen:

« Design: In der dreispaltigen Design-Ansicht wird das
XSLT-Stylesheet als Baum dargestellt. Hier konnen Sie die
Knoten des Quelldokuments den Knoten im XSLT-
Stylesheet grafisch zuordnen.

« Source: Indieser Quellcode-Ansicht konnen Sie das XSLT-
Stylesheet direkt im XML-Editor bearbeiten.

Das Ergebnis von lokal ausgefilihrten XSL-Mappings wird in der
Sicht Output angezeigt.

AuBerdem kénnen Sie Uber die Symbolleiste die folgenden
Aktionen ausfuhren:

« H save content of output view: Daten aus der Sicht Output
speichern

« le= Format the content of the output view: Daten aus der
Sicht Qutput formatieren
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6 Run Transformation

Uber P Run Transformation wird das XSL-Mapping lokal
ausgeflhrt, und das Transformationsergebnis wird in der Sicht
Output (5) angezeigt.

2.5.4.1 Tastenkombinationenim Mapping Editor

Hier finden Sie nitzliche Tastenkombinationen fir die Arbeit mit XSL-Stylesheets in der grafischen
Ansicht des X4 Mapping Editors.

Aktionen per Drag&Drop

Werte mit dem Zielknoten
verknipfen mit xs1:value-
of

Mehrere Werte im
Zielknoten verknipfen mit
xsl:value-of

Knoten kopieren mit
xs'l:copy-of

For-Each-Schleife zu
Knoten erstellen mit
xsl:for—-each

Knoten im Quelldokument per Drag&Drop auf den Zielknoten ziehen

Alt-Taste dricken und alle gewlnschten Knoten im Quelldokument auf
den Zielknoten ziehen

Ergebnis:im select-Attribut des erzeugten xs1:value-of-Elements
werden alle verknipften Elemente nacheinander hinterlegt und
konnen anschlieBend mit einer XPath-Funktion wie concat () oder
logischen Operatoren verknipft werden.

Beispiel: <xs1l:value-of select="Elementl Element2">

Strg-Taste driicken und Knoten im Quelldokument auf den Zielknoten
ziehen

Shift-Taste driicken und Knoten im Quelldokument auf den Zielknoten
ziehen

Funktion Tastenkombination
Basisfunktionen Element bearbeiten Enter

XSL-Transformation ausfihren F9

Element einfligen Einfg

Attribut einfligen Alt+Einfg

Text einflgen Strg+Einfg

UmschlieBendes Eltern-Element einfligen Strg+Shift+Einfg

Element umbenennen Alt+Shift+R

Markierten Knoten entfernen Entf
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Knoten kopieren

Knoten
verschieben

Im Stylesheet-
Baum navigieren

2.5.5

Code formatieren/einriicken (in der Source-Ansicht)

Markierten Knoten als vorangehenden Knoten einfligen

Markierten Knoten als nachfolgenden Knoten einfligen

Markierten Knoten als vorangehenden Eltern-Knoten
einfligen

Markierten Knoten als vorangehenden Knoten
verschieben

Markierten Knoten als nachsten Knoten verschieben
Markierten Knoten als vorangehenden Eltern-Knoten
verschieben

Zum Eltern-Element wechseln

Zum nachsten Geschwister-Knoten wechseln

Zum vorangehenden Element wechseln

Verbundene Knoten in Quelldokument-Bereich und

Stylesheet-Bereich markieren
Letzte Markierung wiederherstellen

Process Editor

Strg+Shift+F

Strg+Alt+Nach
oben

Strg+Alt+Nach
unten

Strg+Alt+Nach
links

Alt+Nach oben

Alt+Nach unten

Alt+Shift+Nach
links

Strg+Shift+Nach
links

Strg+Shift+Nach
unten

Strg+Shift+Nach
oben

Shift+Einfg

Alt+Shift+Nach
unten

Mit dem Process Editor kdnnen Sie technische Prozesse grafisch modellieren. AuBerdem kénnen Sie
flr jeden technischen Prozess und jedem einzelnen Prozessbaustein festlegen, wie diese ausgefihrt

werden sollen.

Mit dem Process Editor konnen Sie unter anderem:

2.5.5.1

@ DerProcess Quality Index ist ein experimentelles Feature. Die Funktionalitat ist derzeit noch

Verbindungen zwischen verschiedenen Backend-Systemen herstellen,
Daten in Echtzeit transformieren,

Geschaftsregeln im modellierten Prozess implementieren und
modellierte Prozesse debuggen und auf dem X4 Server ausfihren

Process Quality Index

eingeschrankt und wird fortwahrend weiterentwickelt.

© SoftProject GmbH
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Der Prozess Quality Index ist ein grafisches Hilfswerkzeug, das angibt, wie qualitativ hochwertig ein

ESB-Prozess im Hinblick auf Kriterien wie die Einhaltung von Standards und die Ubersichtlichkeit

modelliert wurde.

40% 72%
Gewichtung der Kriterien
Kriterien Bedingung Gewichtung
Anzahl der Elemente 100% - <15 Elemente 45%
75% — <20 Elemente
50% - <25Elemente
25% - <30Elemente
0% — >=30 Elemente
Anzahl der Stopp-Elemente 100% —» <3 Elemente 15%
75% - <4Elemente
50% —» <5Elemente
25% - <BElemente
0% - >=6 Elemente
Labels der Elemente sind nicht leer wahr - 100% 10%
falsch - 0%
Prozesstitel wurde gesetzt (nicht Name der  wahr — 100% 5%
Prozessdatei)
falsch - 0%
Labels der Elemente wurden angepasst wahr - 100% 5%

(nicht Dateiname)

falsch - 0%

© SoftProject GmbH
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Kriterien Bedingung

Keine Elemente auf der rechten Seite von wahr - 100%
Stopp-Elementen
falsch - 0%

Keine Elemente auf der linken Seite von wahr - 100%
Start-Elementen
falsch - 0%

Keine Uberlappenden Elemente wahr - 100%

falsch - 0%

Flow Direction Index
Maximum

2.5.5.2 Tastenkombinationen im Process Editor

Gewichtung
5%

5%

5%

5%
100%

Hier finden Sie ndtzliche Tastenkombinationen fir die Arbeit mit dem Process Editors.

Funktion
Prozess Prozess ausfihren
ausfithren und
debuggen

Prozess auf Fehler prifen (und ggf. aktiven
Debugging-Vorgang abbrechen)

Beim Debuggen Einzelschritt ausflihren
und anzeigen (auch in Subprozessen)

Beim Debuggen Prozess-Schritt ausfihren
(ohne Anzeige des Schritte des
Subprozesses)

Beim Debuggen aus Subprozess
herausspringen

Debugging anhalten

Debugging fortsetzen

© SoftProject GmbH

Tastenkombination oder Aktion

F9

F4

F5

F6

F7

Strg+F8

F8
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Debugging abbrechen Strg+F2
Prozessbaustei Prozessbaustein zwischen zwei Datei per Drag&Drop aus dem
ne und verbundenen Bausteinen aus dem Repository auf den Ubergang ziehen.
Ubergénge Repository einfligen Wenn die Linie des Ubergangs dick
einfiigen wird, Maustaste loslassen.

Prozessbaustein von der Ubergangslinie  Alt-Taste driicken und
herunterziehen Prozessbaustein auf der
Zeichnungsflache verschieben

Prozessbaustein entfernen und Alt+Entf
Ubergangslinie behalten

Prozessbaustein durch eine Datei aus dem Datei per Drag&Drop aus dem
Repository ersetzen Repository auf den zu ersetzenden
Prozessbaustein ziehen

Prozessbaustein hinter einem Unverbundenen Prozessbaustein
unverbundenen Baustein einfligen und markieren, Shift-Taste dricken und
dabei automatisch einen Ubergang die Datei aus dem Repository hinter
herstellen den markierten Prozessbaustein ziehen
Elemente Alles auf der Zeichnungsflache auswahlen Strg+A
bearbeiten Prozessbaustein ausschneiden Strg+X
Prozessbaustein kopieren Strg+C
Prozessbaustein einfligen Strg+V
Prozessbaustein entfernen Entf
Bearbeitungsschritt rickgangig machen  Strg+Z
Bearbeitungsschritt wiederherstellen Strg+Y
Prozessbaustein bearbeiten Auf Symbol doppelklicken
Editor schlieBen Strg+W
Bearbeitetes Element speichern Strg+S
Datei im Repository umbenennen F2
Datei im Repository verschieben Datei per Drag&Drop in den Ordner
ziehen
Neu laden F5
Ansicht Prozessdiagramm vergréBern (zoomen) Strg++
bearbeiten Prozessdiagramm verkleinern Strg+-

2.5.6  XML-Editor

Mit dem XML Editor kdnnen Sie wohlgeformte XML-Dokumente erstellen und bearbeiten.

® Um den XML Editor zu starten, legen Sie entweder ein neues XML-Dokument an oder 6ffnen
ein bereits vorhandenes Dokument.

Aufbau des XML-Editors
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« Zum Bearbeiten von XML-Dokumenten stehen zwei Sichten zur Verfligung: die Sicht Design un
d die Sicht Source. Uber die Registerkarten am unteren Rand des Editors kdnnen Sie zwischen
den Sichten wechseln.

=] Customer-Data.xml & |
o=
Node Content
2 xml version="1.0" encoding="UTF-8"
~ [e] Root

v [g] Dataset
[e] CustomerlD
[e] CompanyMName
[e] ContactName
[e] ContactTitle
[e] Address
[e] PostalCode
Created by X4 Designer, Copyright @ SoftProject GmbH. All rights reserve...

Design | Source

Design In der Sicht Design wird die Baumstruktur des gedffneten XML-Dokuments tabellarisch
dargestellt. In der linken Spalte befinden sich die verschiedenen Knoten, die Sie auf- und
zuklappen konnen, sofern Kindknoten existieren. In der rechten Spalte werden die
Inhalte der Knoten angezeigt.

Uber das Kontextmenii kdnnen Sie die folgenden Aktionen ausfiihren:

+ Remove: Markierten Knoten entfernen

« Add DTD Information: Strukturdefinition in Form einer DTD (Document Type
Definition) hinzufligen

« Edit Namespaces: Namensraume bearbeiten

+ Add Attribute: Neues Attribut hinzufligen

« Add Child: Neuen Kindknoten (Element, Processing Instruction usw.) hinzufiigen

» Add Before: Neuen Knoten vor dem markierten Knoten einfligen

« Add After: Neuen Knoten hinter dem markierten Knoten einfligen

Source In der Sicht Source konnen Sie den Quelltext von XML-Dokumenten bearbeiten.

Dabei unterstitzt Sie der Editor durch folgende Funktionen:

« Syntax-Highlighting: Die verschiedenen Knotentypen werden farblich
hervorgehoben.

« Wohlgeformtheit: Beim Speichern erfolgt eine Prifung auf Wohlgeformtheit des
XML-Dokuments.

» Eingabehilfe: Der Editor macht Vorschlage, wenn Sie neue Elemente einfligen
maochten.

« Pretty-Print: Uber das Menii Source > Format kdnnen Sie |hr XML-Dokument mit
EinrGckungen und Zeilenumbrichen lesbarer formatieren.
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3 BPMN-Prozessbausteine und ihre Verwendung

Am rechten Rand der Zeichnungsflache befindet sich eine ausklappbare Werkzeugleiste, die Palette.
Sie enthalt Prozessbaustein-Symbole, die Sie per Drag&Drop in die Zeichnungsflache ziehen kénnen.
Folgende Prozessbausteine stehen fiir die Modellierung von Business Processes (. bpm) zur
Verfligung:

3.1 Events

Beim Anlegen eines neuen Business Process werden standardmaBig bereits ein Start- und ein End-
Event in das Prozess-Diagramm eingefligt. Dariber hinaus lassen sich weitere Event-Bausteine aus
der Palette in das Prozess-Diagramm ziehen und bei der Prozess-Modellierung verwenden. Die
verflgbaren Bausteine werden im Folgenden naher erlautert.

3.1.1 Start

O Start: Definiert gemaB BPMN 2.0 das Start-Ereignis des Business Processes und ermdglicht
die Unterscheidung hinsichtlich verschiedener Ereignistypen.

Eigenschaften

Case Management
Case State Vorgangs-Status, der mit diesem Element gesetzt werden soll

verfligbaren Vorgangs-Statuswerte mit Klick auf &
Vorgangs-Statuswerte verwalten.

! verwalten, siehe

Technical
Label Beschriftung des Symbols im Prozess-Diagramm
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Event

Ereignistyp

Mdgliche Werte:

None Start: Allgemeines Start-Ereignis(Standard)
Error Start: Start-Ereignis bei einem Fehler
Message Start: Nachrichtenbasiertes Start-Ereignis
Multiple Start: Mehrfaches Start-Ereignis

Conditional Start: Start-Ereignis basierend auf einer
Geschéaftsregel

Signal Start: Start-Ereignis, das einem Signal folgt
Timer Start: Zeitgesteuertes Start-Ereignis

Escalation Start: Start-Ereignis basierend auf eine Eskalation
Compensation Start: Start-Ereignis, das auf eine Kompensierung
basiert

Parallel Multiple Start: Mehrfaches paralleles Start-Ereignis

Vorgangs-Status (iber das Start-Event setzen

Mit dem Start-Event kdnnen Sie den Status eines Vorgangs setzen, der zur Laufzeit des Business
Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfiigung. Dazu gehen Sie

wie folgt vor:

1. Start-Baustein im Prozess auswahlen.
2. Inder Properties-Sicht in Eigenschaft Case Management > Case State einen bereits

hinterlegten Vorgangs-Status auswahlen, z. B. START.

® Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein
Vorgangs-Status flr den Business Process definiert. Die verfligbaren Vorgangs-
Statuswerte kdnnen Sie neben dem Wert von Eigenschaft Case State mit Klick auf

verwalten, siehe Vorgangs-Statuswerte verwalten.

Der Vorgangs-Status wird nun bei der Ausflihrung dieses Business Processes auf den neuen
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

@ Alternativ kann der Vorgangs-Status auch dynamisch {iber Technical Processes gesetzt
werden. Hierzu steht der Case Management Adapter zur Verfligung.
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3.1.2 Intermediate

© Intermediate: Definiert gemaB BPMN 2.0 ein Zwischenereignis innerhalb eines Business
Processes und ermdglicht es zudem einen Vorgangs-Statuswert Uber die Eigenschaft Case State zu
setzen, siehe Vorgangs-Statuswerte verwalten.

Eigenschaften

Case Management

Case Vorgangs-Status, der mit diesem Element gesetzt werden soll
State

Mogliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie konnen die verfligbaren

. . £ Lnknown Attachment .
Vorgangs-Statuswerte mit Klick auf verwalten, siehe Vorgangs-
Statuswerte verwalten.

Technical

Docum Pfad zum entsprechenden Prozess im X4 Repository
ent

Label Beschriftungdes Symbolsim Prozess-Diagramm
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Event Ereignistyp

Mogliche Werte:

None Intermediate: Allgemeines Zwischen-Ereignis(Standard)

Message Intermediate (Catch):Eingehendes Nachrichten-Zwischen-Ereignis
Message Intermediate (Throw): Ausgehendes Nachrichten-Zwischen-Ereignis

Cancel Intermediate: Abbruch-Zwischen-Ereignis

Compensation Intermediate (Catch):Eingehendes Kompensations-Zwischen-
Ereignis

Compensation Intermediate (Throw): Ausgehendes Kompensations-Zwischen-
Ereignis

Error Intermediate: Fehler-Zwischen-Ereignis

Escalation Intermediate (Catch):Eingehendes Eskalations-Zwischen-Ereignis
Escalation Intermediate (Throw):Ausgehendes Eskalations-Zwischen-Ereignis
Multiple Intermediate (Catch):Eingehendes Mehrfach-Zwischen-Ereignis
Multiple Intermediate (Throw): Ausgehendes Mehrfach-Zwischen-Ereignis
Conditional Intermediate: Geschaftsregel-Zwischen-Ereignis

Signal Intermediate (Catch): Eingehendes Signal-Zwischen-Ereignis

Signal Intermediate (Throw): Ausgehendes Signal-Zwischen-Ereignis

Parallel Multiple Intermediate: Mehrfaches Parallel-Zwischen-Ereignis
Link Intermediate (Catch):Eingehendes Link-Zwischen-Ereignis
Link Intermediate (Throw):Ausgehendes Link-Zwischen-Ereignis

Vorgangs-Status mit Intermediate Events setzen

Mit Intermediate Events kdnnen Sie den Status eines Vorgangs setzen, der zur Laufzeit des aktuellen

Business Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfiigung. Dazu gehen Sie
wie folgt vor:

1. Intermediate Event aus der Palette in den Zeichnungsbereich ziehen.
2. Firdas markierte Event-Element in der Properties-Sicht in Eigenschaft Case Management >
Case State einen bereits hinterlegten Vorgangs-Status auswahlen, z. B. IN PROGRESS.

verwalten, siehe Vorgangs-Statuswerte verwalten.
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Der Vorgangs-Status wird nun bei der Ausfliihrung diesesBusiness Processes auf den neuen
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

@ Alternativ kann der Vorgangs-Status auch dynamisch tiber Technical Processes gesetzt
werden. Hierzu steht der Case Management Adapter zur Verfligung.

3.1.3 Timer-based Intermediate

69 Timer-based Intermediate : Definiert gemaB BPMN 2.0 ein zeitgesteuertes
Zwischenereignis innerhalb eines Business Processes und ermdglicht es zudem einen Vorgangs-
Statuswert Uber die Eigenschaft Case State zu setzen, siehe Vorgangs-Statuswerte

verwalten .Eigenschaften

Case Management

Case Vorgangs-Status, der mit diesem Element gesetzt werden soll
State

Vorgangs-Statuswerte mit Klick auf &

Technical
Durat Wartezeit biszum Eintreten des Ereignisses
ion

Mdgliche Werte:

« Beliebige Dauer mit Angabe Tagen, Stunden, Minuten, Sekunden und Millisekunden

9999d 23h 59m 59s 999ms
: Maximale Wartezeit

0d Oh Om 0s Oms
: Keine Wartezeit (Standard)

@ Alternativ zur Angabe einer Wartezeit lasst sich (iber Unti1 ein Endzeitpunkt festlegen.

wmi 0der per Doppelklick auf den Event im Prozessdiagramm 6ffnen.

Label Beschriftungdes Symbolsim Prozessdiagramm

3.1.3.1  Zeitgesteuertes Ereignis konfigurieren

1. Timer-based Intermediate Event aus der Palette ins Prozessdiagramm ziehen.
2. Furdas markierte Event-Element in der Properties-Sicht in Eigenschaft Case State einen
bereits hinterlegten Vorgangs-Status auswahlen, z. B.

© SoftProject GmbH
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IN PROGRESS

@ Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein
Vorgangs-Status flur den Business Process definiert. Die verfligbaren Vorgangs-

verwalten, siehe Vorgangs-Statuswerte verwalten.

Der Vorgangs-Status wird nun bei der Ausflihrung dieses Business Processes auf den neuen
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

@ Alternativ kann der Vorgangs-Status auch dynamisch Giber Technical Processes
gesetzt werden. Hierzu steht der Case Management Adapter zur Verfligung.

3. Wartezeit-Konfiguration mit Klick auf kusdneben der Eigenschaft Duration oder per Doppelklick
auf den Event im Prozessdiagramm 6ffnen.

Configure Interval

(®) Duration | 0 = Days |0 3 Hours |0 F Minutes |1 £ Secnnds|D = Milliseconds

s

() Unil |1r;.:-3.::-::- | |13:1?:55 -

Dynamic Configuration

Process

DynamicWaitTime.wrf Create | 3§ Delete | | = Open

4. Gewlnschte Wartezeit durch Angabe von Tagen, Stunden, Minuten, Sekunden
und Millisekunden konfigurieren.

® Alternativ zur Angabe einer Wartezeit lasst sich Uber unti1 ein Endzeitpunkt festlegen.

5. Die Konfiguration mit OK speichern.

3.1.3.2  Zeitgesteuerte Ereignisse dynamisch konfigurieren

Zeitgesteuerte Ereignisse lassen sich auch dynamisch Gber Technical Processes und einem
entsprechenden Mapping konfigurieren. Der entsprechende Technical Process wird Uber das 7imer-
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based Intermediate Eventangelegt und verwaltet. Er wird direkt unter dem entsprechenden Business
Process angelegt und kann auch nicht verschoben werden.

1. Wartezeit-Konfiguration mit Klick auf ki neben der Eigenschaft Duration oder per Doppelklick
auf den Event im Prozessdiagramm &ffnen.

& Dura >
Configure Interval
(® Duration | 0 + Days |0 % Hours |0 F5 Minutes |0 £ SE::ﬂnds|D = | Milliseconds
Ountil  |17.03.2020 08:13:38 3
Dynamic Configuration
Process
o Create Delete Open

2. Unter Dynamic Configuration auf Create klicken.

e Process File Mame b

3 Invalid filename

! QK Cancel

3. Prozessnamen eingeben und mit OK bestatigen.
Der Technical Process wird nun unterhalb des Business Process angelegt und kann hier weiter
bearbeitet werden.

Der Technical Process muss dabei folgende Zielstruktur liefern:
Beispielstruktur: Dauer

<timerBasedConfiguration>
<durationDay>0</durationDay>
<durationHour>0</durationHour>
<durationMinute>0</durationMinute>
<durationSecond>10</durationSecond>
<durationMillis>0</durationMillis>

</timerBasedConfiguration>
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Beispielstruktur: Zeitpunkt

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<timerBasedConfiguration>

<untilTimestamp>2020-03-17T17:00:00</untilTimestamp>
</timerBasedConfiguration>

3.1.4  Non-Interrupting Intermediate Event

e
i

K

unterbrechendes Zwischen-Ereignis (Non-interrupting Intermediate Event)innerhalb eines Busines
Processes und ermdglicht die Unterscheidung hinsichtlich verschiedener Ereignistypen. Im
Unterschied zu Intermediate Eventswird bei einem Non-Interrupting Intermediate Event die
Bearbeitung der Aktivitat nicht unterbrochen, der durch das Ereignis eingeleitete Pfad wird parallel
aktiviert und durchlaufen.

a Non-Interrupting Intermediate Events stehen lediglich im so genannten Free-flow mode des
BPMN Editors zur Verfiigung. Der Free-flow mode lasst sich beim Anlegen von BPM-
Prozessen aktivieren und bietet eine erweiterte Zeichen-Palette. Im Vergleich zum Standard-
Modus ist im Free-flow mode die Run/Debug-Funktion deaktiviert. Zudem lasst sich der
Modus nachtraglich nicht mehr verandern.

Eigenschaften

Docu Pfadzum entsprechenden Prozess im X4 Repository
ment

Labe Beschriftung des Symbolsim Prozessdiagramm
1
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S
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Even Ereignistyp

t

Mogliche Werte:

3.1.5

O End:

Non-Interrupting Message Intermediate (Catch):Eingehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Message Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Catch):Eingehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Catch): Eingehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Throw):Ausgehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Conditional Intermediate: Nicht-unterbrechendes
Geschéftsregel-Zwischen-Ereignis

Non-Interrupting Signal Intermediate (Catch):Eingehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Signal Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Timer Intermediate: Zeitgesteuertes nicht-unterbrechendes

Zwischen-Ereignis

Non-Interrupting Parallel Multiple Intermediate: Mehrfaches nicht-
unterbrechendes Parallel-Zwischen-Ereignis

End

Definiert gemaB BPMN 2.0 ein End-Ereignis des Business Processes.

Eigenschaften

Case Management

Case
State

Technical
Label

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Vorgangs-Statuswerte mit Klick auf ki verwalten, siehe Vorgangs-Statuswerte
verwalten.

Beschriftung des Symbols im Prozess-Diagramm

© SoftProject GmbH

43



X4 BPM

Event Ereignistyp
Mdgliche Werte:

« None End: Allgemeines End-Ereignis(Standard)
« Terminate End: Abbrechendes End-Ereignis(fir alle Prozess-Instanzen)
+ Message End: Nachrichtenorientiertes End-Ereignis

« Cancel End: Abbrechendes End-Ereignis(der laufenden Prozess-Instanz)
« Compensation End: Kompensierendes End-Ereignis

« Error End: End-Ereignis bei einem Fehler

» Escalation End: Eskalierendes End-Ereignis

« Multiple End: Mehrfaches End-Ereignis

« Signal End: End-Ereignis, das einem Signal folgt

Vorgangs-Status tber das End-Event setzen

Mit dem End-Event kdnnen Sie den Status eines Vorgangs setzen, der zur Laufzeit des Business
Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case

State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfligung. Dazu gehen Sie
wie folgt vor:

1. End-Baustein im Prozess auswahlen.
2. Inder Properties-Sicht in Eigenschaft Case Management > Case State einen bereits

hinterlegten Vorgangs-Status auswahlen, z. B. START.

® Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein
Vorgangs-Status flr den Business Process definiert. Die verfligbaren Vorgangs-
Statuswerte kdnnen Sie neben dem Wert von Eigenschaft Case State mit Klick auf

vy

verwalten, siehe Vorgangs-Statuswerte verwalten.

Der Vorgangs-Status wird nun bei der Ausflihrung dieses Business Processes auf den neuen
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

@ Alternativ kann der Vorgangs-Status auch dynamisch tiber Technical Processes gesetzt
werden. Hierzu steht der Case Management Adapter zur Verfligung.

© SoftProject GmbH 44



X4 BPM

3.2  Activities

3.2.1  Activity

! I Activity: Definiert gemaB BPMN 2.0 eine Aktivitat innerhalb eines Business Processes. Der
Aktivitatstyp sowie dessen Ausfiuhrungsverhalten wird durch entsprechende Eigenschaften
festgelegt bzw. durch Marker gekennzeichnet. Mit einem Aktivitats-Baustein lassen sich je nach
Anwendungsfall Technical Processes oder weitere Business Processes als Subprozesse verknipfen.

Eigenschaften

Business
Ad hoc Markierung als Ad-hoc-Aktivitat durch das Symbol =~

Ad-hoc-Aktivitat: zu beliebiger Zeit ausfiihrbare Aktivitat (nur free flow mode)

Compensation Markierung als kompensierende Aktivitat durch das Symbol <<l

Kompensierende Aktivitat: Rickabwicklung von Schritten, die bereits erfolgreich
abgeschlossen wurden

Activity Kennzeichnung des Aktivitatstyps

type
Verfligbare Aktivitatstypen:

None: Allgemeine Aktivitat, ohne zusatzliche Markierung (Standard)
. B4 send: Senden

« B Receive: Empfangen

. 5 Manual: Manuelle Aktivitat

« & Service: Dienst(prozess)

« & script: Skript

Execution Kennzeichnung des Ausfihrungsverhaltens

type
Verfligbare Ausflhrverhaltens-Marker:

« Single: Einfache Ausfliihrung (Standard)

. (ijop:SCNeHe

« Il parallel Multi-Instance: Parallele Mehrfachausfiihrung

= Sequential Multi-Instance: Sequenzielle Mehrfachausfihrung

Technical

Document Pfad zum verknlipften Prozess im X4 Repository (vom X4 Designer gesetzt). Wird ein
Baustein-Symbol aus der Palette per Drag&Drop auf der Zeichnungsflache
eingefligt, so handelt es sich lediglich um einen leeren Prozessbaustein ohne Bezug
zu einer Datei im Repository.
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Label Beschriftung des Symbols im Prozessdiagramm

® Dpie Markierung £ (Teilprozess)wird automatisch gesetzt, sobald ein Business Process
(*.bpm)verkniipft ist.

3.2.2 Human Task

-.l I Human Task: Mit Human Tasks lassen sich menschliche Aktivitat abbilden. Bei der
Automatisierung des Business Processes werden diese Human Tasks mit ausfihrbaren . humantask-
Dateien verknUpft.

Ein Human Task (. humantask) ermdglicht die Konfiguration der Task Management Web App und
damit die Interaktion mit von Menschen ausgefihrten Aufgaben, die im Case Management als
Vorgang modelliert werden, siehe Case Management - Vorgange und Workflows

realisieren. Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm

3.2.2.1  Human Tasks anlegen und verwenden

Um menschliche Interaktionen in Business Processes besser abzubilden, konnen bei der Modellierung
vonBusiness Processes Human Tasks verwendet werden. Diese lassen sich anschlieBend mit einer
Human-Task-Datei (. humantask)verkniipfen in der die Konfiguration des Task vorgenommen wird.
Human Tasks (. humantask)werden unterhalb des Business Processes tiber das Kontextmeni New >

Human task oder Gber die Symbolleiste -+ > Add Human task angelegt. Nach dem Anlegen wird der
Human Task im X4 Designer gedffnet und kann wie folgt parametriert werden:

« Title: Titel der Aufgabe in der Task Management Web App

« Description: Optionale Beschreibung der Aufgabe
« Registerkarte General: Besitzer, zugewiesenen Benutzer oder Gruppe und Frist fir die
Abarbeitung definieren
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4 Approvelnvoice humantask 51 =8

« Owner: Besitzer der Aufgabe
Emgm » Assigned User/Group: Zugewiesener Benutzer
oder Gruppe fur die Aufgabe

C ] @® Die beteiligten Benutzer und Gruppen
— \ werden im Keycloak angelegt und verwaltet.

Duration [0 %] Days[0_[=] Hours [0_[2] Minutes . . . . . .
o « Deadline: Frist fur die Abarbeitung der Aufgabe mit

T folgenden Optionen:
+ No deadline: Keine Frist
« Duration: Dauer der Fristin Tagen, Stunden
und Minuten
« Until: Datumund Uhrzeit zu dem die
Aufgabe abgearbeitet werden muss
+ Case State: Case State der automatisch
ausgefihrt wird, wenn die Frist des Human
Tasks erreicht wurde

@ Wird ein Human Task mit einer
festgelegten Frist ausgefihrt, wird
der Prozess automatisch mit dem
konfigurierten Case State
fortgesetzt, nachdem die Frist
erreicht wurde. Der Human Task wird
in diesem Fall automatisch
geschlossen und innerhalb der Task
Management Web App im Navigator-
Ordner Verfallen angezeigt. Hier
werden alle Human Tasks angezeigt,
die die Frist Gberschritten haben und
automatisch geschlossen worden
sind.

Ist hingegen kein Case State gesetzt,
wird der Prozess auch nicht
automatisch fortgesetzt.

» Registerkarte Business Data: Anzuzeigende Informationen fur die 7Task Management Web App
definieren
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Key Identifier:Case-Featureals
Schllsselkennzeichnung in der Task
Management Web App

Kategorien, Feature-Gruppen und Features
werden in einer baumartigen Struktur angezeigt
und kénnen ausgewahlt werden fir die
Sichtbarkeit in der Task Management Web App
@ Kategorien werden als Tabs in der Task
Management Web App angezeigt.

Display Name: Anzeigename der ausgewahlten
Kategorie, der Feature-Gruppe oder des
Features

read only: Ausgewahlte Kategorie, Feature-
Gruppe und Feature als schreibgeschitzt
kennzeichnen

« Registerkarte Actions: Auszufiihrende Aktionen fir die Task Management Web App definieren

« Unter Actions konnen die Statuswerte

angegeben werden, die vom Benutzer in der
Task Management Web App flr einen Vorgang
gesetzt werden kdnnen

« Display Name: Anzeigename des ausgewahlten

Case States in der Task Management Web App

» Registerkarte Settings: Erweiterte Einstellungen fir die Ver- und Bearbeitung von Vorgangen
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® Ausfiihrung auf dem X4 Server

Im Bereich Advanced das Ablehnen und Weiterleiten von
Tasks erlauben sowie den Zugriff auf Human Tasks (ber eine
Schnittstelle erlauben, siehe Uber ReST-Schnittstelle auf
Human Tasks zugreifen.

+ Task can be declined: Tasks kdnnen
abgelehnt werden

« Task can be forwarded: Tasks kdnnen
weitergeleitet werden

+ Task can be resubmitted: Tasks konnen auf
Wiedervorlage gesetzt werden

« Enable access via API:Den Zugriff auf des
Task Uber eine Schnittstelle erlauben

@ Uber den Task Management Adapter lassen sich
zusatzliche Aktionen flr einen Human Task
definieren.

Im Bereich Documents das Hinzufligen, Bearbeiten und
Ldschen von Dokumenten zu einem Vorgang erlauben.

« Enable Documents: Die Verarbeitung von
Dokumenten erlauben

 Documents can be added/edited:
Das Hinzufligen und Bearbeiten von
Dokumenten erlauben

« Documents can be deleted: Das Ldschen von
Dokumenten erlauben

Lauft ein Business Process wahrend der Ausfiihrung auf einen Human Task, wird die
Ausflihrung des Prozesses angehalten und die menschlichen Aufgabe generiert. Der Prozess
wartet auf die notwendige menschliche Interaktion innerhalb der Task Management Web App
und setzt die Ausfiihrung fort, sobald die menschliche Aufgabe zu dem Prozess

abgeschlossen ist.

3.2.2.2

Human Task Uber einen Technical Process dynamisch parametrieren

Human Tasks lassen sich nicht nur iber Human-Task-Dateien konfigurieren, sondern auch dynamisch

Uber Technical Processes.

Folgende Einstellungen des Human Tasks lassen sich im Technical Process Ubersteuern:

« Owner
e Assignee
e Deadline

Der Technical Process zur Parametrierung des Human Tasks wird direkt unter dem Human Task Gber
das Kontextmeni New > Process angelegt und kann auch nicht verschoben werden.
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Das Input- und Output-Dokument fiir den Technical Process sieht wie folgt aus:

Struktur des Input- und Output-Dokuments

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<HumanTask>
<Owner>0wnerName</Owner>
<Assignee>
<name>AsigneeName</name>
<type>user|group</type>
</Assignee>

<!-- Deadline types (NoDeadline, DurationDeadline, UntilDeadline)-->
<NoDeadline />

<DurationDeadline>
<Days>7</Days>
<Hours>4</Hours>
<Minutes>45</Minutes>

</DurationDeadline>

<UntilDeadline>2019-04-18T14:30:49+02:00</UntilDeadline>
</HumanTask>

3.2.2.3  Uber ReST-Schnittstelle auf Human Tasks zugreifen

® Hinweis
Die Anmeldung Uber BasicAuth wird fir X4 APl nicht mehr unterstitzt. Fir den Aufruf der X4
APl ist jetzt ein Bearer-Token erforderlich. Dieses kann tber http://localhost:8080/X4/
X4Api/ oder mit dem Adapter Keycloak Token abgerufen werden.
Dieser Hinweis gilt nur fur X4 API, far die anderen Services ist BasicAuth weiterhin verflgbar.
Die Dokumentation der ReST-Schnittstelle finden Sie unter http://localhost:8080/X4/X4Api/.

Anstelle der Task Management Web App kdnnen auch andere Anwendungen fir die Anzeige und
Bearbeitung von Human Tasks verwendet werden. Die Anbindung findet Gber eine Webservice-
basierte Schnittstelle statt, die alle Funktionalitaten bietet, die auch in der Task Management Web
App verfligbar sind.

Der Zugriff auf den Human Task Uber die ReST-Schnittstelle kann pro . humantask-Datei ermdglicht
werden.

Um die Anbindung Uber die ReST-Schnittstelle zu ermdglichen, missen folgende Einstellungen im
Human Task vorgenommen werden:
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1. Human Task offnen.

2. Die Registerkarte Settings 6ffnen.

3. Im Bereich Advanced die Option Enable access via API wahlen.
Der Zugriff ist nun ausschlieBlich tGber die Schnittstelle moglich.

@Swa gerEditor.  Filev Edity Insertv  GenerateServer v  Generate Client v

Task Management®

API to access and work with tasks

default v

/rest/tasks/{uuid}/documents/{fileName} Getthe Document including metadata
/rest/tasks/{uuid}/documents/{fileName} Updates the given document
/rest/tasks/{uuid}/documents/{fileName} Addsa new document to the case where the task belongs to

‘m /rest/tasks/{uuid}/documents/{fileName} Deletes the document

/rest/tasks/{uuid} Retums atask assigned to the user

nt including metadata

/rest/tasks/{uuid}/cancel Cancelsthe ediing of the task and releases itfor other users

/rest/tasks/{uuid}. {fileName} Get the D

/rest/tasks/{uuid}/documents/{fileName}/metadata Updates the given documents metadata

/rest/tasks/{uuid}/documents/metadata Get the Documents metadata

/rest/tasks/{uuid}/close Updates features of the task, closes the task and continues the case

3.2.3 Rule

-.E /' Rule: Mit dem Rule-Baustein lassen sich Regeln fiir Entscheidungen innerhalb eines
Business Processes abbilden. Die anzuwendenden Regeln werden dabei innerhalb von
Entscheidungstabellen (. rule)nach DMN 1.1definiert. Die Regeln kdnnen automatisiert geprift und
die Ergebnisse fur die Weiterverarbeitung an den Business Process zurlickzugeben werden.

@ DMN ist ein Standard zur Modellierung von Entscheidungen in Business Processes. Im
Standard DMN ist auch die Simple Expression Language (S-FEEL) definiert, eine formale
Ausdruckssprache zur Definition einer Entscheidungslogik.

DMN 1.1 mit S-FEEL ist online verfligbar unter https://www.omg.org/spec/DMN/1.1/.

Eigenschaften

Label Beschriftung des Symbols im Prozessdiagramm
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3.2.3.1  Rules anlegen und definieren

a

« Defaultwerte des Typs Integer und Decimal kénnen nicht leer sein.
» Beiden Typen Integer und Decimal kann nicht geprift werden, ob der Wert leer ist.

Um Regeln fr Entscheidungen in Business Processes besser abzubilden, kdnnen bei der
Modellierung von Business Processes Rule-Bausteine verwendet werden. Diese lassen sich
anschlieBend mit einer Entscheidungtabelle (. rule)verknipfen, in der die Definition der Regeln
vorgenommen wird.

o Verkettung von Entscheidungstabellen
Es konnen beliebig viele Entscheidungstabellen in einem Business Process verkettet
werden. Ausgangswerte der einen Tabelle werden somit zu Eingangswerten der

nachfolgenden. Dadurch lassen sich komplexe Entscheidungsbaume mit entsprechenden

Verzweigungen modellieren.

Entscheidunstabellen(. rule)werden unterhalb des Business Processes (iber das Kontextmeni New

> Rules oder Gber die Symbolleiste -+ > Add Rules angelegt. Nach dem Anlegen wird die
Entscheidungstabelle im X4 Designer gedffnet.

= Rule.rule &3 = O
= L
i = m;f
Inputs Outputs Annotation
Invoice amount Currency Released by 1
u Input Input Variable
number string string J
/InvoiceData  /InvoiceData ReleasedBy
1 not("EUR") "Manager" Amounts in a foreign currency must be released by the manager.,
2 <100 "EUR" = Small amounts are released automatically.
3 <1000 "EUR" “Clerk" Clerks may release amounts up to 1000 euros.
4 <5000 "EUR" "DepartmentManager” Department manager may release amounts up to 5000 euros.
5 "EUR" "Manager" Large amounts must be released by the manager.

| ) J
DMMN Decision Table Editor | Source ]’ ]’

Nr. Element Beschreibung

1 Werkzeugleiste Funktionen zum Bearbeiten von Entscheidungstabellen, abhangig von
Kontext und Auswahl
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Nr.

Element Beschreibung
Kopfbereich Einstellungen zur Definition von Input und Output, wobei mehrere Inputs
und Outputs moglich sind.
Folgende Zellen sind zur Definition des Inputs und Outputs verfligbar:
1. Freitextfeld flr den Spalten-Namen
2. Input-bzw. Output-Quelle
+ Input bzw. Output: Input aus dem BPMN-Prozess
bzw. Output an den BPMN-Prozess
« Parameter: Auswahl eines Parameters (nur fir Input
verfligbar)
« Variable: in einer Variable hinterlegter Wert (ohne
Leerzeichen, z. B. FreigabeDurch)
» Case State: Auswahl eines Status
» Case Feature: Auswahl von Fachdaten
3. Datentyp des Inputs bzw. Outputs(string, number, boolean)
4. Input-Pfad als Freitextfeld oder Auswahl (je nach Input-Quelle)
bzw. Name des Outputs oder der Variablen als Freitextfeld oder
Auswahl (je nach Output-Ziel)
Annotation Freie Anmerkung, die nicht im Output ausgegeben wird
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Nr.

4

Element
Regeln

Beschreibung

Regeln fur die Transformation von Inputs zu Outputs.

Regeln werden pro Zeile definiert, wobei die Reihenfolge der Zeilen die
Uberprifungsreihenfolge vorgibt. Eine Regel hat mindestens eine Spalte
zur Verarbeitung der Eingangswerte (Input) und mindestens ein
Entscheidungs-Ergebnis (Output).

Die Regelnin der Entscheidungstabelle werden in der S-FEEL-Notation
angegeben. Damit |asst sich die Entscheidungslogik in natlrlicher Sprache
"business-friendly" beschreiben. Gleichzeitig erlaubt sie als formale
Auszeichnungssprache mit festgelegter Semantik, Grammatik und
definierten Regeln die Interpretation und das Ausfihren von Werten. S-
FEEL kann Zeichenketten, Zahlen, einfache arithmetische Operationen
und simple Vergleichsprifungen interpretieren.

(@ Beachten Sie:

Zeichenketten in Anflihrungszeichen setzen, z. B.
"Abteilungsleiter"

Fir Dezimalzahlen einen Punkt als Trennzeichen verwenden,
z.B.5.1

Ist der Wert einer Zelle der Input-Spalte nicht fir eine Regel
relevant, entsprechend S-FEEL ein - (Minuszeichen)in die Zelle
eingeben

Eine Entscheidungstabelle kann eine Fallback-Regel enthalten,
die immer zutreffen soll. Hierzu enthalten alle Zellen der Input-
Spalten einer Fallback-Regel ein - (Minuszeichen).

Ob eine Fallback-Regel sinnvoll ist und an welcher Stelle der
Uberprifungsreihenfolge sie stehen sollte, hangt von der Hit
Policy und dem Anwendungsfall ab.
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Nr. Element

5

Hit Policy

Beschreibung

Einstellung zur Auswahl der Ergebnisse. Sie legt fest, wie viele Regeln
einer Entscheidungstabelle zutreffen kdnnen und wie die Ergebnisse
ausgegeben werden.

@ Regeln kénnen so definiert werden, dass die Anzahl und Auswahl
der Ergebnisse gegen die Hit Policy verstdBt. In diesem Fall
mussen je nach Anwendungsfall die Regeln oder die Hit Policy
korrigiert werden.

Bedeutung Maglicher VerstoB gegen die Hit
Policy

U (Unique): Nur eine Regel kann « Keine zutreffende Regel

zutreffen und es wird genau ein « Mehrere zutreffende

Ergebnis ausgegeben. Regeln

F(First): Eine oder mehrere Regeln Keine zutreffende Regel

kdonnen zutreffen, es wird aber nur das
erste Ergebnis ausgegeben.

@ Uberpriifungsreihenfolge beachten!

A(Any): Eine oder mehrere Regeln mit + Keine zutreffende Regel
demselben Ergebnis kdnnen zutreffen, « Mehrere zutreffende

es wird jedoch nur ein Ergebnis Regeln mit
ausgegeben. unterschiedlichen

Ergebnissen

C(Collect): Alle zutreffenden Keine zutreffende Regel
Ergebnisse werden ohne feste
Ausgabereihenfolge ausgegeben.

® Der fertige BPMN-Prozess mit der Entscheidungstabelle kann im X4 Designer validiert, auf
Fehler Uberprift und auf dem X4 Server ausgefuhrt werden.
Entscheidungstabellen konnen zu drei Ergebnissen flhren:

Ilcon

Beschreibung

Der Rule-Baustein liefert ein oder mehrere Ergebnisse. Das Zwischenergebnis ist
aufrufbar.

Der Rule-Baustein liefert keine Ergebnisse. Mégliche Ursachen:

« Firden Input gilt keine der definierten Regeln
» Regeln fehlerhaft, z. B. Schreibfehler
« Hit Policy nicht geeignet

Der Rule-Baustein liefert einen Fehler, da die Entscheidungstabelle nicht konform
zu S-FEEL ist. Ein Bericht mit einer Erklarung des Fehlers ist aufrufbar.
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3.2.5.2  S-FEEL-Ausdrucke zur Definition von Regeln

Operator / Ausdruck

Vergleic 10
h

v:[Variablenname]

f:[Featurename]

. p:
[Platzhaltername]

e c:[CaseState]

not()

Intervall [1..10]

(1..10]
[1..10)
(1..10)

Disjunkti 3,5,7
on

<2,>10
10, [20..30]

"Meier", "MG1ller, "Weber"

Beschreibung

Priift, ob der Eingabewert gleich dem angegebenen Wert
ist,z. B. 10

Flahrt eine Prifung auf Basis einer Variablen, eines
Features, eines Parameters oder eines Vorgangs-
Statuswertes (Case State) durch

® Mitstrg+ Leertaste lassen sich alle aktuell
verfligbaren Variablen, Features, Parameter und
Vorgangs-Statuswerte in einer Auswahlliste
aufrufen.

Prift, ob der Eingabewert kleiner als der angegebene Wert
ist,z.B. < 10

Prift, ob der Eingabewert kleiner oder gleich dem
angegebenen Wertist, z. B. <= 10

Prift, ob der Eingabewert groBer dem angegebenen Wert
ist,z.B.> 10

Prift, ob der Eingabewert groBer oder gleich dem
angegebenen Wertist, z. B. >= 10

Prift, ob der Eingabewert nicht kleiner oder gleich dem
angegebenen Wert ist, z. B. not (<=106)

Priift, ob der Eingabewert groBer oder gleich dem Startwert
und kleiner oder gleich dem Endwert ist

Prift, ob der Eingabewert groBer als der Startwert und
kleiner oder gleich dem Endwert ist

Priift, ob der Eingabewert gréBer oder gleich dem Startwert
und kleiner als der Endwert ist

Prift, ob der Eingabewert groBer als der Startwert und
kleiner als der Endwert ist

Prift, ob der Eingabewert 3,5 oder 7 ist

Priift, ob der Eingabewert weniger als 2 oder mehr als 10 ist

Prift, ob der Eingabewert entweder 10 oder zwischen 20
und 30 ist

Priift, ob der Eingabewert entweder Meier, Mlller oder
Weber ist

® Eine umfangreiche Referenz zur Syntax der S-FEEL Notation finden Sie in der aktuelle
Spezifikation zu DMN 1.1(Kapitel 9) der Object Management Group. https://www.omg.org/

spec/DMN/1.1
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3.5 Sequence Flow

—»
Sequence Flow: Verbindet in einem Business Process die einzelnen Events, Gateways und

Activities und definiert die Reihenfolge der Prozess-Schritte durch seine Pfeilrichtung.

@ Sobald Sie mit der Maus {iber Events, Gateways oder Activities fahren, wird ein Pfeil am
rechten unteren Rand des Elements angezeigt. Klicken und ziehen Sie den Pfeil, um eine
Sequenzfluss-Linie zu erstellen.

X7+
Activity
b
Eigenschaften
Label Freitextfeld zur Beschriftung der Sequenzfluss-Linie (zur Gbersichtlicheren Gestaltung

bzw. Dokumentation)

Log4d Log Logging Uber Log4jan dieser Stelle des Prozesses mit den aktuellen Input-Daten

auf Ed klicken.

Madgliche Werte:

« Disabled: Keine Log4j-Aktion wurde festgelegt (Standard)
+ Enabled: Eine Log4j-Aktion wurde festgelegt
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Save Point

Source
Component

Target
Component

Priority

Condition

Save Point an dieser Stelle des Prozesses setzen, um den kompletten Zustand der
Prozess-Engine mit den verarbeiteten Daten und Statusinformationen bei der
Ausflhrung einer Prozess-Instanz im Dateisystem zu persistieren. Die Prozess-Instanz
kann vom letzten gespeicherten Save Point Gber X4 BAMwiederaufgesetzt werden.

Madgliche Werte:

« No Savepoint: Kein Save Point wurde festgelegt (Standard)

+ Save and Continue: Save Point erstellen und die Prozess-Ausfiihrung direkt
fortsetzen

+ Save and Stop: Save Point erstellen und die Ausflihrung der Prozess-Instanz
anhalten

» Delete: aktuellen Save Point Idschen
Baustein, an dem die Sequenzfluss-Linie beginnt (wird vom X4 Designer gesetzt)
Baustein, zu dem die Sequenzfluss-Linie fihrt (wird vom X4 Designer gesetzt)

Bei Gabelungen(Parallel Gateways (Forking))und Verzweigungen(Exclusive
Gateways (Forking)): Positionin der Ausfiihrreihenfolge (Prioritat)

Mogliche Werte:

» Beliebige positive ganze Zahl
« 1:Hochste Prioritat (Standard)

Bei Bedingungs-Bausteinen: vom Condition Manager hinterlegte Ausfiihr-Bedingung

3.4  (Gateways

Innerhalb von fachlichen Prozessen (Prozessdiagramme mit der Dateiendung . bpm) kénnen Sie
folgende Gateways gemaB BPMN 2.0 verwenden:

3.4.1  Parallel Gateways

® Parallel Gateway Definiert gemaB BPMN 2.0 ein paralleles Gateway fiir logische
(Forking) UND-Verzweigungen

@® Parallel Gateway Definiert gemaB BPMN 2.0 ein synchronisierendes Gateway flr die
(Synchronizing) Zusammenfuhrung von parallelen Sequenzflissen

® wenn Sequenzfliisse mit Parallel Gateways "parallel" modelliert wurden, bedeutet dies keine
gleichzeitige, sondern vielmehr eine gleichberechtigte Ausfihrung. Die tatsachliche
Ausflhrreihenfolge der parallel geflihrten Sequenzflisse konnen Sie (ber deren Prioritat (in
Eigenschaft Priority)festlegen, siehe Sequence Flow.

Eigenschaften
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Labe Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenfiihrung (zur
1 Ubersichtlicheren Gestaltung bzw. Dokumentation)

Parallel Gateways verwenden

1. Parallel Gateway (Forking}Element aus der Palette per Drag&Drop ins Prozessdiagramm
ziehen.

2. Furjeden Ausflhrungszweig eine Sequence Flow-Linie ausgehend vom Parallel Gateway
(Forking}-Element erstellen.
Alle Ausfiihrungszweige werden nun unabhangig voneinander ausgefiihrt und besitzen
denselben Input.

3. Falls gewlnscht, Uber die Eigenschaft Priority der markierten Sequence Flow-Linie die
Ausflhrreihenfolge der einzelnen Ausflhrungszweige verandern.

® Inausfihrbaren Prozessen werden die Ausflhrungszweige mit der niedrigsten Wert in P
riority zuerst ausgeflhrt.

4. Parallel Gateway (Synchronizing)}-Element aus der Palette per Drag&Drop in ein
Prozessdiagramm ziehen.

5. Sequence Flow-Linien der Ausfihrungszweige mit dem Parallel/ Gateway
(Synchronizing}Element verbinden.
Inausflhrbaren Prozessen wird das Ausgabe-Dokumente des letzten ausgefiihrten Elements
innerhalb der Gabelung an den nachsten Prozess-Schritt weitergegeben.

Beispiel: Parallel Gateway (Forking) mit 3 parallelen, priorisierten Verzweigungen und Parallel Gateway
(Join):

[

3.4.2  Inclusive Gateways

© Inclusive Definiert gemaB BPMN 2.0 ein datenbasiertes inklusives Gateway fir logische
Gateway ODER-Verzweigungen
(Forking)

© Inclusive Definiert gemaB BPMN 2.0 ein synchronisierendes Gateway fir die
Gateway Zusammenflihrung von inklusiven datenbasierten Sequenzfllissen
(Synchronizing
)
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® Inclusive Gateways fUhren in der Praxis schnell zu wenig sinnvollen Konstrukten. Daher
empfehlen BPM-Experten wie Jakob Freund, Bernd Riicker und Thomas Henninger im
Praxishandbuch BPMN(ISBN: 978-3-446-41768-7), diese Elemente sparsam zu verwenden
und stattdessen Exclusive- und Parallel Gateways zu kombinieren.

Eigenschaften

Labe Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenfihrung (zur
1 Ubersichtlicheren Gestaltung bzw. Dokumentation)

Cond Ausfiihr-Bedingung(wird vom Condition Editor automatisch gesetzt) fiir die Verzweigung
itio (Forking).
n

Auf die Ubergangslinie doppelklicken, um Bedingungen zu hinterlegen oder auf kud klicken,

um den Condition Editor zu 6ffnen.

Beispiel: Inclusive Gateway (Forking) mit 3 inklusiven Verzweigungen und synchronisierendem
Inclusive Gateway (Synchronizing)

1
&=

]

3.4.3  Exclusive Gateways

® Exclusive Gateway Definiert gemaB BPMN 2.0 ein Gateway fur exklusive Verzweigungen
(Forking)

® Exclusive Gateway Definiert gemaB BPMN 2.0 ein synchronisierendes Gateway fur die
(Synchronizing) Zusammenfihrung von exklusiven datenbasierten Sequenzflissen

Eigenschaften

Label Freitextfeld zur Beschriftung des exklusiven Verzweigung bzw.

Zusammenfiihrung (zur Gbersichtlicheren Gestaltung bzw.
Dokumentation)

Condition Ausflhr-Bedingung der Verzweigung (wird vom Condition Editor
automatisch gesetzt); auf die Ubergangslinie doppelklicken, um

Bedingungen zu hinterlegen oder auf ki klicken, um den Condition
Editor zu 6ffnen.

Exklusive Gateways verwenden
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1. Exclusive Gateway (Forking)}-Element aus der Palette per Drag&Drop ins Prozessdiagramm
ziehen.

2. Furjeden Ausflihrungszweig eine Sequence Flow-Linie ausgehend vom Exclusive Gateway
(Forking}-Element erstellen.
Alle Ausfiihrungszweige besitzen denselben Input.

3. Exclusive Gateway (Forking}Element doppelklicken, um die Bedingungen fiir die einzelnen
Ausfihrungszweige festzulegen.
Der Condition Editor wird gedffnet. In diesem Editor kénnen Sie fiir jede
ausgewahlte Sequence Flow-Linie eine Bedingung definieren, siehe Bedingungen erstellen und
verwenden.

4. Falls gewtlinscht, Uber die Eigenschaft Priority der markierten Sequence Flow-Linie die
Ausfuhrreihenfolge der einzelnen Ausflhrungszweige verandern.

® In ausfiihrbaren Prozessen werden die Ausfihrungszweige mit der niedrigsten Wert in P
riority zuerst ausgeflhrt.

5. Exclusive Gateway (Synchronizing)}-Element aus der Palette per Drag&Drop ins
Prozessdiagramm ziehen.

6. Sequence Flow-Linien der Ausfuhrungszweige mit dem Exclusive Gateway
(Synchronizing)-Element verbinden.
Inausflihrbaren Prozessen wird das Ausgabe-Dokument des letzten ausgefihrten Elements
innerhalb der Gabelung an den nachsten Prozess-Schritt wie in technischen Prozessen
weitergegeben.

® DaBusiness Processes im BPMN-Standard keine Variable-Bausteine enthalten, kdnnen
Kontextvariablen mit Exclusive Gateways nur ausgewertet werden, wenn die
Kontextvariablen innerhalb von technischen Prozessen definiert wurden und diese
technischen Prozesse als Aktivitat im Business Process verknipft wurden. Hierzu stehen
im Business Process Kontextvariablen zur Verfligung, die in verknlpften Technical
Processes, nicht aber etwaigen Subprozessen dieser Technical Processes, initialisiert
wurden.

Beispiel: Exclusive Gateway (Forking) mit 3 exklusiven Verzweigungen und synchronisierendem
Exclusive Gateway (Synchronizing):

1
=
J I 4

] U]

=

1

© SoftProject GmbH 61



X4 BPM

3.5  Artefakte

Innerhalb eines Business Process (Prozessdiagramme mit der Dateiendung . bpm) kdnnen Sie
folgende Artefakte gemaB BPMN 2.0 verwenden:

3.5.1 Message Flow

& . . .
o Message Flow: Werden mehrere Pools verwendet, um eine Zusammenarbeit zwischen

verschiedenen Partnern zu modellieren, wird der Informationsaustausch zwischen diesen Pools mit
Nachrichtenflissen gekennzeichnet.

& Beachten Sie, dass Nachrichtenflisse ausschlieBlich zur Visualisierung von logischen
Zusammenhdangen dienen!
Bei der Ausflihrung des Business Processes Uber den X4 Server werden ausschlieBlich
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die Gber Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.

Eigenschaften

Label Freitextfeld zur Beschriftung des Nachrichtenflusses (zur tibersichtlicheren
Gestaltung bzw. Dokumentation)

Line Linienflhrung
Routing
Madgliche Werte:

+ Angled: Angewinkelte Linie
« Straight: Gerade Linie (Standard)

Line Type Linienstil
Mogliche Werte:

. Dash line: Gestrichelte Linie (Standard)
+ Solid line: Durchgezogene Linie

« Dot line: Gepunktete Linie
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Line Color

Line
Source
Decorator

und Line
Target
Decorator

und auf Esd klicken.

Madgliche Werte:

«  RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Symbol fiir den Linienanfang und das Linienende

Mogliche Werte:

« Circle: Kreis/Ellipse (Standard)

« Empty arrow: Ungeflllter Pfeil

» Association arrow: Offener Pfeil

« Arrow: Geflllter Pfeil

« Inverted arrow: Umgekehrter Pfeil
« Diamond: Geflllte Raute

« Empty diamond: Ungefillte Raute

« Plain: Kein Symbol

3.5.2 Association

=

«“ Association: Logische Verbindung innerhalb eines Business Processes zwischen
Prozessbausteinen (Events, Gateways oder Activities) und Artefakten (Pools, Data Objects,
Annotations oder Groups) oder Zeichnungselementen. Dient vor allem zu Dokumentationszwecken.

& Beachten Sie, dass Assoziations-Linien ausschlieBlich zur Visualisierung von logischen
Zusammenhéangen dienen!
Bei der Ausfiihrung des Business Processes Uber den X4 Server werden ausschlieBlich
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die Gber Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.

Eigenschaften

Label

Freitextfeld zur Beschriftung der Assoziations-Linie (zur Gbersichtlicheren
Gestaltung bzw. Dokumentation)
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Line Routing Linienflhrung

Mogliche Werte:

« Angled: Angewinkelte Linie
« Straight: Gerade Linie (Standard)

Line Type Linienstil
Mdgliche Werte:

« Dash line: Gestrichelte Linie (Standard)
« Solid line: Durchgezogene Linie

« Dot line: Gepunktete Linie

Line Color Farbe der Assoziations-Linie; Um die Farbe zu andern, die Eigenschaft markieren

und auf Easd klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Line Source  Symbol firden Linienanfang und das Linienende
Decorator und

Line Target Madgliche Werte:

Decorator

« Circle: Kreis/Ellipse (Standard)

« Empty arrow: Ungeflllter Pfeil

« Association arrow: Offener Pfeil
« Arrow: Geflllter Pfeil

« Inverted arrow: Umgekehrter Pfeil
« Diamond : Geflllte Raute

« Empty diamond: Ungeflllte Raute

+ Plain :Kein Symbol

3.5.3 Pool/Lane

] Pool/Lane: Gliedert gemaB BPMN 2.0 einen Business Process in Zustandigkeiten und Beteiligte.
Laneswerden innerhalb eines oder mehrerer sogenannter Pools definiert und reprasentieren somit
Zustandigkeiten von Aktivitaten. Mit Pools werden die beteiligten Organisationen, Systeme u. a.
dargestellt, wobei ein Pool beliebig viele Lanes enthalten kann. In der Pool/Lane-Darstellung wird der
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zeitliche Prozessablauf zumeist von links oben nach rechts unten angeordnet.

Eigenschaften

Pool Freitextname des Pools (wenn ein Pool markiert ist)

Name

Lane Freitextname der Lane (wenn eine Lane markiert ist)

Name

Line Linienfarbe des Pools oder der markierten Lane; Um die Farbe zu andern, die
Color Eigenschaft markieren und auf kud klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (Uber den Farbauswahldialog wahlbar)
« RGB(0,0,0): Schwarz(Standard)

Line Linienbreite des Pools oder der markierten Lane in Pixel
Width
Madgliche Werte:

» Beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)

Fill Fallfarbe des Pools oder der markierten Lane; Um die Farbe zu andern, die Eigenschaft

Color markieren und auf ki klicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (Uber den Farbauswahldialog wahlbar)
e RGB(255, 255, 255):WeiB(Standard)

Pools und Lanes in Business Processes verwenden

Mit Pools werden die beteiligten Organisationen, Systeme u. a. dargestellt, wobei ein Pool beliebig
viele Lanes enthalten kann. In der Pool/Lane-Darstellung wird der zeitliche Prozessablauf zumeist von
links oben nach rechts unten angeordnet.

1. Pool einfigen und bearbeiten:

» Aus der Palette das Pool-Symbol I per Drag&Drop auf die Zeichnungsflache ziehen.

« PerKlick den Pool verschieben oder durch Ziehen der Eckpunkte beliebig skalieren.

« Beschriftung des markierten Pools andern: In der Properties-Sicht in Pool Name einen
anderen Text eingeben.

« Formatierung andern: In der Properties-Sichtin Fill Color oderLine Color die
Fillfarbe oder die Linienfarbe auswahlen und auf £
aufzurufen.

2. Lane zu einem Pool hinzufligen:

i klicken, um eine Farbpalette
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« Auf einen Pool rechtsklicken und aus dem Kontextmenl Add Lane wahlen.
« Beschriftung der markierten Lane andern: In der Properties-Sicht in der
Eigenschaft Lane Name einen anderen Text eingeben.
« Hintergrundfarbe oder Linienfarbe andern: In der Properties-Sicht die Eigenschaft Fill

Color bzw. Line Color auswéhlen und auf kmi klicken, um eine Farbpalette aufzurufen.

3.5.4  DataObject

B Data Object: Bindet ein beliebiges Daten-0Objekt ein, z. B. eine Datei aus dem X4 Repository.

Eigenschaften

Docu Pfad zum verknipften Dokument im Repository.
ment

Labe Beschriftung des Symbolsim Prozess-Diagramm
1

Oper Bestimmt, ob die Datei gelesen oder geschrieben werden soll
atio
n Mogliche Werte:

e Read: Dokument in den Prozess einlesen und Daten an den nachsten Prozess-Schritt
weitergeben (Standard)

» Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

3.5.6 Data Store

% Data Store: Dientzur Visualisierung einer verwendeten Datenbank.

& Beachten Sie, dass Datenspeicher ausschlieBlich zur Visualisierung von logischen
Zusammenhangen dienen!

Eigenschaften

Docu Pfad zum verknlpften Dokument im Repository.
ment

Labe Beschriftung des Symbolsim Prozess-Diagramm
1

Oper Bestimmt, ob die Datei gelesen oder geschrieben werden soll
atio
n Mogliche Werte:

« Read: Dokument in den Prozess einlesen und Daten an den nachsten Prozess-Schritt
weitergeben (Standard)

» Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

© SoftProject GmbH 66



X4 BPM

3.5.6 Annotation

[Abe Annotation: Flgt eine freie Anmerkung ein, deren Text Sie per Doppelklick in einem
Dialogfenster bearbeiten und formatieren kénnen.

@ Mit einer Association-Linie kénnen Sie die Annotation mit einem Prozessbaustein logisch
verbinden.

Eigenschaften

Hyperl Hinterlegte Verlinkung fur die Anmerkung. Zum Verlinken eine gultige URL eintragen.
ink
@ Mit strg+Klick lasst sich die eingetragene URL aufrufen.

Text Textinhalt der freien Anmerkung; Um den Text zu dandern und zu formatieren, die

?  Unknown Attachment

Eigenschaft markieren und auf klicken.

Fill  Fillfarbe der Anmerkung; Um die Farbe zu &ndern, die Eigenschaft markieren und auf fus:
Color  Kklicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (liber den Farbauswahldialog wéahlbar)
« RGB(255, 255, 255):WeiB(Standard)

Transp Anmerkungsflache als transparent setzen. Durch Aktivieren der Eigenschaft, wird die
arent Eigenschaft Fill Color aufgehoben.

3.5.7  Group

=% Group: Fasst Elemente optisch zusammen, um zusammengehdrige Gruppen zu visualisieren.

Eigenschaften

Line Linienfarbe der Gruppe; um die Farbe zu andern, die Eigenschaft markieren und auf

Color ? Unknown Attachment

klicken.

Modgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog wahlbar)
« RGB(160,160,160): Grau(Standard)
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Line Linienbreite des Gruppenelements

Width
Mogliche Werte:

« Beliebige positive ganze Zahl
« 2: 2 Pixel breite, gestrichtelte Linie (Standard)

3.6 Drawing

Folgende Zeichnungselemente kdnnen Sie in samtlichen Prozesstypen verwenden:
3.6.1  Connection

D_%_qunnect'ion: Verbindungsbaustein: Gibt den Input aus dem vorangegangenen Prozess-Schritt
ebenso wie dessen Status unverandert aus. Es markiert den jeweiligen Ausfiihrungszweig fir den X4
Server eindeutig. So lasst sich mit diesem Baustein in Schleifen der Rlicksprung zum ersten
Schleifenbaustein explizit setzen. Es verbindet einen Cond1ition-Baustein mit einem Stop-Baustein
oder hilft dabei die Positionierung einer Verbindung explizit zu verédndern.

3.6.1.1  Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm (lasst sich dort auch
Uber die F2-Taste bearbeiten)

Beispiele

« Connection zwischen Condition und Schleifenriicksprung: Bei Schleifenrlickspriingen wird als
letzter Schleifenbaustein ein Connection-Baustein gesetzt.

‘ Bestelung
erfassen
Start

[2] n=in

E=|
Daten volstandig? o Bestelung
[1j= absenden

None End
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« Connection zwischen Condition und Stop: Zwischen einem Cond1tion-Baustein und
einem Stop-Baustein wird ein Connection-Baustein gesetzt.

- The® SR
End

« Connection zum Positionieren von Verbindungslinien: Verbindungslinien werden
normalerweise automatisch positioniert. Um die Positionierung explizit zu verandern, kdnnen
Verbindunsbausteine eingesetzt werden.

( j Activity [

Start

( ) Activity

End

3.6.2 Connector

/ Connector: Ermdglicht die logische Verbindung von beliebigen Elementen.

® Connector-Verbindungslinien ausschlieBlich zur Visualisierung von logischen
Zusammenhangen!
Bei der Ausfihrung Gber den X4 Server werden ausschlieBlich Prozessbausteine in den

Daten-und Kontrollfluss mit einbezogen, die in Business Processes Gber Sequenzfluss-Linien

(siehe Sequence Flow) bzw. in Technical Processes (iber Transition-Ubergangslinien
verbunden sind (siehe Transition).

Eigenschaften

Label Freitextfeld zur Beschriftung der Verbindungslinie (zur Gbersichtlicheren
Gestaltung bzw. Dokumentation)

Line Routing  LinienfUhrung
Modgliche Werte:

+ Angled: Angewinkelte Linie
« Straight: Gerade Linie (Standard)
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Line Type

Line Color

Line Source
Decorator und
Line Target
Decorator

Linientyp
Mogliche Werte:

« Dash line: Gestrichelte Linie (Standard)
« Solid line: Durchgezogene Linie

« Dot line: Gepunktete Linie

Farbe der Verbindungslinie. Um die Farbe zu andern, die Eigenschaft markieren

......

und auf ki klicken.

Modgliche Werte:
« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog

wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Symbol fir den Linienanfang

Mdgliche Werte:

+ Circle: Kreis(Standard)

« Empty arrow: Ungeflllter Pfeil

» Association arrow: Offener Pfeil

« Arrow: Geflllter Pfeil

« Inverted arrow: Umgekehrter Pfeil
« Diamond: Geflllte Raute

« Empty diamond: Ungeflllte Raute

« Plain: Kein Symbol

3.6.5  Rectangle und Ellipse

- Rectangle

< Ellipse

Eigenschaften

Zeichnet ein beliebiges Rechteck

Zeichnet eine beliebige Ellipse
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Line Color

Line Width

Hide Line

Fill Color

Transparent

Rahmenfarbe. Um die Farbe zu &ndern, die Eigenschaft markieren und auf Eus:
klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)
Linienbreite des Zeichnungselements
Mogliche Werte:

« beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)

Rahmenlinie ausblenden

markieren und auf ki klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(255, 255, 255):WeiB(Standard)

Zeichnungselement als transparent kennzeichnen. Durch Aktivieren der Eigenschaft

wird die Eigenschaft Fil1l Color aufgehoben.

3.6.4 Textbox

Abc Textbox: Flgt einen Textrahmen ein, dessen Inhalt Sie per Doppelklick in einem Dialogfenster

bearbeiten und formatieren konnen.

Eigenschaften

Hyperlink

Text

markieren und auf &

Hinterlegte Verlinkung fir das Textfeld. Zum Verlinken eine giiltige URL eintragen.
@ Mit strg+Klick lasst sich die eingetragene URL aufrufen.

i klicken.
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Rotation Drehung des Textrahmens

Mogliche Werte:

0: keine Drehung(Standard)

90: um 90° gegen den Uhrzeigersinn drehen

186: um 180° drehen

276: um 270° gegen den Uhrzeigersinn drehen

Fill Color Flullfarbe des Textfeldes. Um die Farbe zu andern, die Eigenschaft markieren und auf
wd klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (liber den Farbauswahldialog wahlbar)
e RGB(255, 255, 255):WeiB(Standard)

Transparen Textfeld als transparent setzen. Durch Aktivieren der Eigenschaft wird die
t Eigenschaft Fill Color aufgehoben.

3.6.5  Polygon

& Polygon: Zeichnet ein Polygon mit beliebig vielen Eckpunkten.

Eigenschaften

Line Color Rahmenfarbe. Um die Farbe zu &ndern, die Eigenschaft markieren und auf fu:
klicken.

Mogliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)
Line Width Linienbreite des Zeichnungselements
Madgliche Werte:

« beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)
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Fill Color Flllfarbe des Zeichnungselements. Um die Farbe zu andern, die Eigenschaft
markieren und auf kad klicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (Uber den Farbauswahldialog
wahlbar)

« RGB(255,255,255): WeiB (Standard)

Transparent Transparente Fillung(keine Fillfarbe verwenden). Durch Aktivieren der Eigenschaft
wird die Eigenschaft Fi1l Color aufgehoben.

3.6.6  Polylineund Line
AP Zeichnet eine Linie mit beliebig vielen Wegpunkten

Polyline

Yo Zeichnet eine gerade Linie
Line

Eigenschaften

Line Linienfarbe. Um die Farbe zu &ndern, die Eigenschaft markieren und auf ki klicken.
Color
Madgliche Werte:
« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (Uber den Farbauswahldialog wahlbar)
- RGB(0,0,0): Schwarz(Standard)
Line Linienbreite des Zeichnungselements
Width
Madgliche Werte:
 beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)
3.6.7 Image

Image: Flgt einen Bildrahmen ein, mit dem sich eine Grafikdatei vom Typ .gif, . jpg, .png
oder .bmp einbinden lasst.

® Das eingefligte Bild wird im Prozess gespeichert.
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Eigenschaften

Line
Color

Line
Width

Image
File

auf kad klicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (iber den Farbauswahldialog wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Linienbreite des Zeichnungselements

Madgliche Werte:

+ beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)

Pfad der verknlpften Grafikdatei
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4 Mit BPM-Projekten arbeiten

Das X4 Repository ist in Projekten organisiert. Projekte besitzen eine Dateisystem-Struktur und
konnen beliebige Ordner, Prozesse, Prozessbausteine und andere Dateien enthalten.

4.1  Die Struktur von BPM-Projekten

BPM-Projekte haben eine vordefinierte und nicht veranderbare Ordnerstruktur, die beim Anlegen
eines neuen BPM-Projekts automatisch angelegt wird. Die automatisch angelegten Ordner und
Unterordner kdnnen nicht geldscht, verschoben oder umbenannt werden.

Projekt

Processes

Resources

4.2  BPM-Projekt anlegen

Activities

Auf oberster Ebene des Projektes lassen sich
Prozesslandkarten(.pld)erstellen.

Innerhalb des Ordners Processes kdnnen beliebig viele BPM-
Prozesse (.bpm)angelegt werden. Hier ist ebenfalls der
Ordner Activities mit seiner vordefinierten Struktur enthalten.

Der Ordner Activities enthalt folgende Unterordner, die jeweils
nur vordefinierte Dateien enthalten dirfen:

Adapters: Hier kbénnen lediglich Ordner und Adapter-
Dateienvom Typ . faund . traangelegt werden.
DomainMode'l: Hier kdnnen beliebig viele .domainmodel-Da
teien angelegt werden, in denen Vorgangs-Fachdaten
definiert werden.

Processes: Hier kdnnen technische Prozesse (.wrf)zur
Verknipfung mit den Aktivitaten abgelegt werden.
Resources: Hier kdnnen Ressourcen wie Bilder, Text- und
XML-Dokumente sowie weitere Dateien abgelegt werden.
TemporaryFiles: Hier kobnnen temporare Dateien wie Text-
und XML-Dokumente abgelegt werden.

Transformations: Hier kdnnen Transformationen(.xs1)
sowie Reports(.rep)abgelegt werden.

Hier konnen neben Ordnern auch Ressourcen wie Bilder, Text- und
XML-Dokumente sowie weitere Dateien abgelegt werden.

Sie haben verschiedene Mdglichkeiten, um ein BPM-Projekt im X4 Designer anzulegen:

« Uber New BPM Project auf der Welcome-Seite des X4 Designers
. Uber das Kontextmenii New > BPM Project in der Sicht Projects
- Uber das Menii File > New > BPM Project

So legen Sie ein BPM-Projekt an
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1. Wahlen Sie im X4 Designer File >New > BPM Project aus.

e

|
| BPM Process File Name
Select template from the list and enter a file name. @

Blank Start with a blank BPM process

File name: | BPM_process_1.bpm

l/?j' < Back Mext > Cancel

2. Wabhlen Sie ein leeres Projekt oder eine vorhandene Projektvorlage aus.

Geben Sie unter File name den Namen des Projekts ein.

4. Klicken Sie auf Finish, um das Projekt anzulegen.
In der Sicht Projects wird ein leeres BPM-Projekt mit der vordefinierten Struktur angelegt.
Uber das Kontextmenii kdnnen Sie nun Elemente fiir lhr BPM-Projekt auswahlen und im
jeweiligen Ordner anlegen. Welche Optionen im Kontextmen verfligbar sind, hangt davon ab,
an welcher Stelle in der Baumstruktur das Kontextmenu aufgerufen wird.

W

® Wenn Sie beim Anlegen des Projekts den Projekttyp Expert BPM Project auswahlen, knnen
Sie ein leeres BPM-Projekt ohne vorgegebene Ordnerstruktur anlegen und im Expertenmodus
arbeiten. Bei diesem Projekttyp kdnnen Sie die Ordnerstruktur und die darin enthaltenen
Elemente selbst festlegen.
Hinweise zur Verwendung von BPM-Projekten aus dlteren X4-Versionen:
« BPM-Projekte aus X4-Versionen vor 6.x werden automatisch in ein Expert BPM Project
importiert.
« Classic BPM Projects aus alteren X4-Versionen werden automatisch in ein Expert BPM
Project umgewandelt.

4.5  Prozesslandkarten modellieren

Mit einer Prozesslandkarte (Process Landscape) konnen Sie Prozesslandschaften im X4 Designer
Ubersichtlich darstellen und beliebige Prozesse und andere Dokumente verknipfen.

Alle relevanten Prozesse kénnen Sie hier grafisch darstellen und der logische Zusammenhang von
Prozessen lasst sich kompakt dokumentieren. Eine so erstellte Prozesslandkarte bietet somit eine
Ubergeordnete Sicht auf Flihrungs-, Wertschopfungs- und Unterstltzungsprozesse und bilden die
Grundlage fir das Qualitatsmanagement.
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Prozesslandkarten werden auf oberster Ebene eines BPM-Projektes angelegt. Jedes BPM-Projekt
darf nur eine Prozesslandkarte erhalten, welche den Projektnamen als Namen tragt, z. B.
Demoprojekt.pld. Prozesslandkarten sind nicht ausfiihrbar, sondern dienen lediglich der Ubersicht
Uber Business Processes, die sich in Block Arrow-Elementen verknlipfen lassen. Zudem kénnen Sie
Uber Data Objects beliebige weitere Repository-Dateien verknipfen.

=] "BPM_Examples.pld 2 = &
1¢ Palette [
(= Process Landscape Elements ¢
Welcome to X4 BPM Examples! = B
(= Drawing @
Business Process Management (BPM) means the analysis, modeling, implementation and documentation of repetitive tasks within a business context. u/“ O © oAbk
The main goal of BPM is to model recurring processes efficiently and to automate them This allows processes to run faster and with fewer errors and & W

leads to more cost-effectiveness.

Repository structure
Examples
This folder shows how to implement processes and services with the X4 ESB.
Invoice Receipt Ordering Process PizzaOrder

This process shows how to integrate an This process shows a fully automated This little process shows the a first .

user into a BPM process by using X4 process for handling orders froma webshop. approach to executable BPM processes in

Adtivities for handling hurman tasks. the X4 BPM Suite.

Double click on this processes!

Requirements Please note
- Full installaticn of X4 BPM Suite Some processes are not executable, because remote applications, mail
- E-mail client, PDF viewer, and an SVG-enabled web browser accounts or additional data are required. Those processes are marked as
- Intermnet connection (for some processes) prototypes.

This X4 Experience installation is for evaluation purposes only! It is not
intended for any production use!

(c) SoftProject

4.4 Business Process erstellen

Mit dem BPMN Editor konnen Sie fachliche Business Processes gemaB BPMN 2.0 modellieren.

Sie kdnnen sowohl leere Aktivitaten aus der Palette als auch Dateien aus der Sicht Projects auf die
Zeichnungsflache ziehen und in der Sicht Properties die jeweiligen Eigenschaften konfigurieren, um
einen ausfihrbaren Business Process zu erstellen.

@ Im Free-flow-Modus besteht zudem die Mdéglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterten BPMN-Palette zu verwenden, wobei die Run/Debug-
Funktion deaktiviert ist.

Um einen neuen Business Process anzulegen, gehen Sie wie folgt vor:

1. Klicken Sie mit der rechten Maustaste auf den Ordner Processes, und wahlen Sie im
Kontextmenl New > Business Process....
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Das Dialogfenster Process Creation Wizard wird gedffnet.
#4 Process Creation Wizard O x

Business Process File Name
| [

Select template from the list and enter a file name.

Blank Start with a blank Business process
File name: BPM_process.bpm
Process title: BPM_process

Process description:

Free-flow mode:

? Finish | Cance

2. Wabhlen Sie eine leere Prozessvorlage oder eine vorhandene Prozessvorlage.
3. Geben Sie im Feld File name einen Prozessnamen ein.
@ Leerzeichen und Umlaute sind im Dateinamen nicht erlaubt!

4. Geben Sie im Feld Process title einen Prozesstitel ein.

Der Prozesstitel wird im Prozessdiagramm angezeigt und kann in der Sicht Properties tber die
Eigenschaft Title verandert und bei Bedarf Gber die Eigenschaft Show Title ein-und
ausgeblendet werden.

@ Um die Eigenschaft Show Title anzuzeigen, klicken Sie in der Sicht Properties auf das
Symbol Show Advanced Properties.

5. Hinterlegen Sie ggf. im Feld Process description eine Prozessbeschreibung. Die Angabe einer
Prozessbeschreibung ist optional.

6. Aktivieren Sie Gber das Kontrollkastchen Free-flow mode ggf. den Free-flow-Modus fir
Geschaftsprozesse. Bei aktiviertem Free-flow-Modus wird der BPMN Editorals reines BPMN-
Zeichenwerkzeug mit einer erweiterten BPM-Palette verwendet.

@ Im Free-flow-Modus ist die Run/Debug-Funktion deaktiviert.

7. Wahlen Sie Finish, um den Prozess anzulegen.

Ein leerer Business Process wird mit der Dateinamensendung . bpmin der Sicht Projects
erstellt und im BPMN Editor gedffnet.

8. Modellieren Sie den Business Process wie gew(lnscht:

« Ziehen Sie Bausteine aus der Palette oder Dateien aus der Sicht Projects per Drag&Drop
auf eine bereits vorhandene Ubergangslinie zwischen zwei Prozessbausteinen oder an
eine freie Stelle auf der Zeichnungsflache.

. Zeichnen Sie ggf. Ubergangslinien, um die Prozessbausteine zu verbinden. Gehen Sie
dazu wie folgt vor:
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» Fahren Sie mit dem Mauszeiger Uber den Quellbaustein, um einen kleinen Pfeil
anzuzeigen.
« Klicken Sie auf den Pfeil, und ziehen Sie eine Linie zum Zielbaustein.

AuBerdem konnen Sie:

« Pools und Swimlanes einfligen, siehe Pool/Lane.
« Event-Elemente einfligen, siehe Events.
« Parallel Gateway-Elemente oder Exclusive Gateway-Elemente einfligen, siehe Gateways.

® Tipp
Uber das Menii Project > Validate Project lasst sich der Business Process iiber einen
integrierten Prozess-Validator auf Gultigkeit prufen.
Wenn Sie Dateien aus der Sicht Projects in [hren Prozess einbinden und diese in der
Sicht Properties entsprechend konfigurieren, kdnnen Sie den modellierten Prozess Uber >
ausfiihren. Ausgenommen sind Prozesse im Free-flow-Modus.

4.4.1 Nutzung von Private Files unterhalb von Business Processes

Wenn Prozessressourcen nur innerhalb eines Business Processes verwendet werden sollen, lassen
sich diese direkt unterhalb eines Elternprozesses anlegen. Damit kdnnen sie ausschlieBlich im
Prozesskontext verwendet werden und lassen sich aus anderen Business Processes auch nicht
aufrufen.

Grundsatzlich lassen sich unterhalb eines einzelnen Business Processes die gleichen Ressourcen
anlegen wie innerhalb eines BPM-Projektes - seien es weitere Business Processes (. bpm),
Technical Processes(.wrf), Human Tasks (. humantask), Rules(. rule)oder Domain Models
(.domainmodel).

w %% SarmnpleBPMProject
» [ Proceszes

(= Activities
Cal B Mew * [&] BPM Process..
= Reso
&P X4Come Open %2 Process..
Open With > Domain Model...

Save As Ternplate... 1 AT
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® Die zu verwendenden Ressourcen konnen sowohl Uber das Kontextmeni New >

<Ressourcenname> als auch tber die Symbolleiste

werden.

* > Add <Ressourcenname> angelegt

Die angelegten Ressourcen lassen sich anschlieBend wie gewohnt parametrieren und per
Drag & Drop aus dem Repository in das Prozessdiagramm einbauen, siehe auch Human
Task, Rule, Vorgangs-Fachdaten verwalten.

4.5  Business Process im BPMN- oder XML-Format importieren

Mit dem BPMN 2.0 Import Wizardlassen sich Prozessdiagramme aus anderen
Modellierungswerkzeugen, die im Format . xml oder .bpmn vorliegen, als neue Business Processes ins

X4 Repository importieren.

1. Uber das Menii Project > Import BPMN 2.0 Process den BPMN 2.0 Import Wizard 6ffnen.

w. Bprn 2.0 Import Wizard
Import BPMN 2.0 Process

Select the file to import and enter a file name,
Input:

Gy

|~~'ZJ|

Finish

| Pt

s

Browse...

Cancel

2. Browse klicken, um die gewlinschte Datei zu wahlen.

@ Sie kénnen anhand der Endung .xm1(Standard) oder .bpmn nach der Datei filtern.

3. Die Datei auswahlen und mit Offnen bestétigen.
Die Datei wird nun im Wizard ausgewahlt.
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4. Finish klicken, um die Datei zu importieren.
Die Datei wurde nun importiert und wird als Business Process im Repository Navigator
angezeigt.

4.6 Eigenschaften von Business Processes(.bpm)

Business Processes (. bpm)werden iber den BPMN Editor grafisch modelliert und kénnen auf dem X4
BPM Server ausgeflihrt werden, wenn samtliche Bausteine entsprechend parametriert und korrekt
mit Repository-Dateien verknipft wurden.

® Dpie Eigenschaften jedes Business Processes lassen sich in der Properties-Sicht des BPMN
Editors bearbeiten, wenn im BPMN Editor ein freier Bereich der Zeichnungsflache angeklickt
wird.
StandardmaBig werden die gebrauchlichsten Eigenschaften angezeigt, Uber die Symbolleiste
der Properties-Sicht lassen sich jedoch zusatzliche Einstellungen vornehmen:

il

-1 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen
3P

. |

Show Advanced Properties: Erweiterte Eigenschaften anzeigen

Eigenschaften

Documentation

Created Erstelldatum des Prozesses
Created by Name des Prozess-Erstellers
Last Update Datum der letzten Anderung

Last Update by Name des letzten Bearbeiters
Title Freitextfeld fir den Prozesstitel

Version Projektversion

@ Wenn keine Version gesetzt ist, wird der Zeitstempel als Version genommen.

Technical
Can Stop Geschaftsprozess darf wahrend der Ausfiihrung angehalten werden

@ Diese Eigenschaft wird nicht an Subprozesse vererbt.

Modgliche Werte:

e True: fUr normale Prozesse (Standard)

e False: fur kritische Prozesse, die zu Ende laufen missen
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Free-flow mode

In service

Instance limit

Schedule

Stop on error

Schema
Declaration

Zeigt an, ob der Free-flow-Modus aktiviert ist. Dabei wird die erweiterte
BPMN-Palette freigeschaltet, um den BPMN Editor als reines BPMN-Zeichen-
Werkzeug zu verwenden.

® . Diese Option kann beim Anlegen des Business Processes aktiviert
werden und nicht nachtraglich gedndert werden.
» Im Free-flow-Modus ist die Run/Debug-Funktion flr den aktuellen
Business Process deaktiviert.

Prozess aktiv oder inaktiv setzen. Werden inaktive Prozesse direkt ausgefihrt,
so erhalten sie die Prozess-ID -1 . Subprozesse, also Prozesse, die in anderen
Prozessen aufgerufen werden, kdnnen unabhangig von dieser Eigenschaft
immer ausgefliihrt werden.

Mogliche Werte:

« True: Prozess kann ausgefiihrt werden (Standard)

« False: Prozess kann nicht ausgefiihrt werden (nur als Subprozess)

Maximale Anzahl von Instanzen dieses Prozesses, die parallel ausgeflihrt werden
darfen.

& Beachten Sie!

Instance limitwirdignoriert, wenn der Prozesse als Subprozess
aufgerufen wird.

Schedule-Werkzeug, das zeitgesteuertes Ausflihren von Prozessen auf dem X4

Eigenschaft markieren und auf ki klicken.

Mogliche Werte:

« Disabled: Kein Zeitplan wurde festgelegt (Standard)

« Enabled: Ein Zeitplan fir die Ausfihrung des Prozesses wurde hinterlegt

Im Fehlerfall die Prozess-Ausfihrung anhalten

Modgliche Werte:

« True: Prozess-Ausflihrung abbrechen, wenn ein Fehler auftritt (Standard)

» False: Prozess-Ausflhrung nicht abbrechen, wenn ein Fehler auftritt
(sofern moglich)

Schema fir Input und Output des Prozesses
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4.7  Prozesskomponenten ausrichten

Prozessbausteine lassen sich tGber den KontextmenU-Eintrag Layout auf einfache Weise aneinander
ausrichten. Damit Iasst sich schnell und einfach eine saubere, strukturierte Darstellung generieren.

Dazu die gewiinschten Prozesskomponenten auswahlen und Gber Rechtsklick das Kontextmen
aufrufen. AnschlieBend Layout und die gewiinschte Option wahlen.

Folgende Optionen stehen fur das Ausrichten der Prozesskomponenten zur Verfigung

« Align Horizontal: Komponenten anhand des Mittelwertes horizontal ausrichten
« Align Vertical: Komponenten anhand des Mittelwertes vertikal ausrichten

« Distribute Horizontal: Komponenten gleichmaBig horizontal verteilen

« Distribute Vertical: Komponenten gleichmaBig vertikal verteilen

= -]
Write Invoice Check 2
Automaticaly Add Component >
Start  Invoice Frd

Layout > & Align Horizontal

F  Align Vertical

[ Distribute Horizontal
T Distribute Vertical

.

£ Undo Delete

Select All
Copy
o Cut
% Copy Process Diagram to Clipboard

Checkl  Egjt |abel —"E E
in X4 A

& Delete None End

® Firdie Optionen Align HorizontalundAlign Vertical missen mindestenszwei
Prozesskomponenten ausgewahlt sein, fur die Optionen Distribute
HorizontalundDistribute Vertical mindestens drei Komponenten.

4.8 Prozess-Metadaten hinzuflgen

Bei Bedarf kdnnen Sie beliebig viele weitere Metadaten zur Prozessdefinition eines Technical
Processes oder Business Processes hinzufliigen und bearbeiten, z.B. fir Dokumentationszwecke.
1. Im Prozess Editor auf einen leeren Bereich der Zeichnungsflache klicken, um in der Properties-
Sicht die Prozesseigenschaften anzuzeigen.
? Unknown Attachment

2. Die Eigenschaft Metadata > Manage Metadata wahlenund auf
klicken.
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Ein Dialog wird gedffnet, in dem Sie beliebige Schlissel/Wert-Paare definieren kdnnen.

w. Custom Metadata

Entries:

CustomMetadataMame [CustombetadataValue]

Add
Remowve
Up

Down

O

Metadata properties:

Mame:

*

| [CustomMetadatalame

Value:

CustomMetadatalalue

3. Metadaten-Eigenschaften eingeben:

« In Name den Name des Metadatums eingeben, z.B. Version.
« InValue den entsprechenden Wert eingeben, z.B 1. 1.
4. Umdie Reihenfolge eines selektierten Metadatums zu andern, auf Up oder Down klicken.

5. OKklicken, um die Einstellungen zu speichern.

Das Metadatum wurde nun hinzugefligt und wird in der Properties-Sicht angezeigt. In der
Prozessdefinitionsdatei werden die Metadaten im XML-Speicherformat abgelegt.

® Uber Schaltfliche Remove kdnnen Sie ein selektiertes Metadatum I6schen.

4.9  Projekte importieren

Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressorcen aus dem lokalen Dateisystem ins

Repository importieren.

4.9.1 Importieren via Drag&Drop

Aus dem Dateisystem (z. B. vom Desktop oder dem Windows Explorer) kdnnen Sie eine oder mehrere
markierte Dateien per Drag & Drop in den Repository Navigator und damit ins aktuell verbundene
Repository importieren. Falls eine Datei gleichen Namens am Ziel bereits vorhanden ist, werden Sie

aufgefordert, einen neuen Namen einzugeben.

© SoftProject GmbH

84



X4 BPM

® Beachten Sie:

« Ordnerstrukturen werden beim Import nicht unterstiitzt, verwenden Sie hierzu den
entsprechenden Wizard.

- BeigroBeren Dateilibertragungen (insgesamt Gber 1 MB) wird ein Bestatigungsdialog
eingeblendet, da méglicherweise Verzégerungen bei der Ubertragung sowie
Arbeitsspeicher-Probleme auftreten kdnnen.

« Importierte Dateien, die Sonder-/Leerzeichen oder Umlaute im Dateinamen enthalten,
mussen zunachst umbenannt werden, bevor Sie diese im X4 Designer 6ffnen kénnen.

« Projekte verfligen Uber eine vordefinierte Struktur, sodass die eingefligten Dateien nur
im jeweils vordefinierten Ordner abgelegt werden kénnen, siehe auch Die Struktur von
ESB-Projekten

4.9.2  Import Wizard fur Dateien und Projekte nutzen

® Beachten Sie

» Projekte verfligen Uber eine vordefinierte Struktur, sodass die zu importierenden
Dateien nurim jeweils vordefinierten Ordner abgelegt werden kénnen, siehe auch Die
Struktur von ESB-Projekten

« Projekte konnen lediglich auf oberster Ebene und in der vordefinierten Projektstruktur
importiert werden, siehe auch Die Struktur von ESB-Projekten

1. Men( Projekt > Import aufrufen.
Der Resource Import Wizard wird aufgerufen.
2. Resource auswahlen.
. Uber Browse die zu importierende Datei (. z1ip) oder das zu importierende Projekt
wahlen und in New project/file name den entsprechenden Namen eingeben.
3. Finish klicken.

410 Projekte exportieren

Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressorcen aus dem Repository ins
Dateisystem exportieren.

4.10.1  Export Wizard fur Dateien und Projekte nutzen
® Beachten Sie

« Projekte kdnnen nur dann exportiert werden, wenn die oberste Projektebene
ausgewahlt ist.
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1. Menu Projekt > Export aufrufen.

Der Resource Export Wizard wird aufgerufen.
2. Zielordner auswahlen.
3. Speichernklicken.
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5 Case Management

Mit dem Case Management im X4 Designer konnen Sie vorgangsbezogene Ablaufe mitsamt
Fachdaten, Fachstatus und fallbezogenen Aufgaben abbilden.

Definieren Sie Fachdaten und Fachstatus direkt in den Business Processes - so modellieren Sie nicht
nur den Ablauf, sondern definieren gleichzeitig auch ein Prozessdatenmodell, mit dem Sie komplexe
Vorgange abbilden kénnen, z. B. spezifische Freigabeprozesse oder Prozesse, die verschiedene
Status durchlaufen.

Hinterlegen Sie Kategorien, Gruppen und Merkmale, um lhre Fachdaten abzubilden. Fachdaten, wie
Rechnungsnummern kdnnen direkt zur Laufzeit im Prozess hinterlegt und Geschaftsregeln auf deren
Basis definiert werden.

Geben Sie verschiedene Fachstatus direkt bei der Modellierung der Business Processes an. Die
definierten Status kdnnen in den erstellten BPMN-Diagrammen Uber Ereigniselemente,
Entscheidungstabellen, Gateway-Elemente oder Human Tasks ausgewertet bzw. gesetzt werden.

5.1 Vorgange und Workflows realisieren

Menschen lassen sich in Business Processes typischerweise iber Aufgaben einbinden. Bei der
Modellierung von Business Processes passiert dies Uber einen Human Task.

Lauft ein Business Process wahrend der Ausfiihrung auf einen Human Task, wird die Ausflihrung des
Business Processes angehalten und die menschlichen Aufgabe generiert. Der Prozess wartet auf die
notwendige menschliche Interaktion und setzt die Ausfihrung fort, sobald die menschliche Aufgabe
zu dem Prozess abgeschlossen ist.

@ Mit der Version 7.0 der X4 BPMS wurde die Art und Weise, wie Vorgénge und Workflows mit
Case Management realisiert werden, umgestellt. Wenn Sie von einer Version 6.x auf eine 7.x
aktualisieren, werden vorhandene Prozesse automatisch migriert.

Anhand des folgenden Beispiels soll die typische Umsetzung mit der X4 BPMS dargestellt werden.

1. Business Process wie gewlinscht modellieren.
Im Beispiel wird ein Freigabeprozess dargestellt, bei dem je nach freizugebenden Betrag
entweder eine automatische Freigabe oder eine Freigabe durch verschiedene
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Prozessbeteiligte erfolgt.

(& InvoiceApproval.bpm 52

Approval of electronic invoices

=
L] £ mport == g
L 3 e Approve
%;’ —@T> S O
Stat

ystem

e
£ Invoice is Automatically
mported Approved
&
Approve .
P (Clerk) 1] Task finished 'O
Approved by Clerk
12 De:dln‘eleacned
&  Approve
(Head of 4.0
@ department)

Head of department

Approved by
Head

2. Die entsprechenden Fachstatus und Fachdaten definieren:
- Zum Definieren des Fachstatus(.state), siehe Vorgangs-Statuswerte verwalten.

(&) InvoiceApproval.bpm | &= Casestate 33 =0
Add | | Delete
Case States State
Inveice is imported Name

To be approved automatically
To be approved by clerk

To be approved by head of department Description
Approved
Declined
Deadline reached

Case States Source

- Zum Definieren der Fachdaten(.domainmodel), siehe Vorgangs-Fachdaten verwalten.

+ SampleDomainModel.domainmodel £3

Add.. = Delete

Structure

w Electronic Invoice
~ Invoice Data
InvoiceMumber
InvoiceDate
InvoiceAmount
InvoiceCurrency
w Inveice Sender
Sender Information
~ Invoice Receiver
Receiver Information

Category

Name

= 0

Electronic Invoice

Description

Dara representation of the electronic invaice

Business Data Configuration | Source

3. Uber eine Aktivitit werden die Daten eingelesen. Die Aktivitat ist mit einem technischen
Prozess verknupft, der die Daten ausliest und den Uber den Case Management Adapter alle
Features(Merkmale) ausgibt.

4. Uber ein Intermediate wird der Status des Vorgangs gesetzt.

Hierzu stehenin der Eigenschaft Case State des Intermediate Events alle prozessweit
definierten Vorgangs-Statuswerte zur Auswahl zur Verfligung.
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5. Uber Entscheidungstabellen (.rule) werden die Regeln hinterlegt, um die Aufgabe je nach Hohe
des Betrags der entsprechenden Person zuzuweisen. Im Input wird dabei angegeben, woher die
zu priifenden Daten kommen. Uber Case Feature werden die zuvor definierten Merkmale
(siehe Vorgangs-Fachdaten verwalten) angegeben.

@ Mit Entscheidungstabellen lassen sich auch Variablen, Features, Parameter oder
Statuswerte (Case State)auswerten. Dazu lassen sich mit Strg + Leertaste im Regel-
Bereich alle aktuell verfligbaren Variablen (v : vVariablenname), Features
(f:Featurename), Parameter (p:Parametername)und Vorgangs-Statuswerte
(c:CaseState)in einer Auswahlliste aufrufen.

= Rulerule E1 = B
i = il
Inputs Outputs Annotation
Invoice amount Currency Released by
u Input Input Variable
number string string
/InvoiceData
1 = not("EUR") "Manager" Amounts in a foreign currency must be released by the manager.
2 <100 "ELR" = Small amounts are released automatically.
3 <1000 "ELIR" "Clerk” Clerks may release amounts up to 1000 euros,
4 <5000 "ELIR" "DepartmentManager” Department manager may release amounts up te 3000 eures,
L "ELIR" "Manager" Large amounts must be released by the manager.

DMM Decision Table Editor | Source

6. Mit einem Condition-Baustein werden die verschiedenen Ausfiihrungszweige abgebildet. Im
Condition Editorkdnnen die Vorgangszustande des aktuellen Business Processes als
Auswertungskriterium flr die Bedingungen verwendet werden, siehe Bedingungen erstellen
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und verwenden.

| »4 Condition Editor ] X
Branch
\ Parameters ~ BRANCH_SEQUENCE_FLOW [#3 "Audit invoice" -> #4 "Approve (automati..”] ~
R Project Parameters
> Global Parameters
» @\ @
» System Parameters A“dt nvoice > R (automatncal =
~ Case Management Q
CASE_STATE
O
O
NI ADIJTOVG
2 (Clerk)
Condition
] Tif CASE_STATE = To be approved automatically
o A
]
nar
¥ Delet: CASE_STATE = To be approved automatically
Edit Condition
Components Parameters (@ Variables
If result of CASE_STATE v s = ~ | To be approved automati. v

Close

7. Flrjeden Ausflihrungszweig den entsprechenden Prozessschritt konfigurieren. Bei Bedarf
muss der Human Task und damit die Funktionen der Task Management Web App konfiguriert
werden.

8. Prozess speichern und ausfihren.

9. Die Task Management Web App Uber das Men( Tools > X4 Task Management 6ffnen.

10. Inder Task Management Web App einloggen.
Die zu bearbeitenden Vorgange werden nun angezeigt.

® Welcher Benutzer einen Vorgang bearbeiten darf, wird Uber den Rule-Baustein
ausgewertet.

11. Vorgange wie gewlinscht bearbeiten.

® Welche Bearbeitungsfunktionen verfligbar sind, hangt von der Konfiguration im Human
Task ab.

5.2 Vorgangs-Fachdaten verwalten

Um Vorgange mit X4 BPM abzubilden, ist es erforderlich, die bendtigte Struktur der Fachdaten fur den
Business Process zu definieren. Uber Domain-Model-Dateien (. domainmodel) kdnnen Sie eine
dreistufige Hierarchie mit Fachdatenstrukturen inklusive der zugehoérigen Beschreibung definieren
und somit der Prozessdefinition hinzufigen.
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5.2.1  Aufbauvon Vorgangs-Fachdaten

Fachdaten eines Vorgangs werden in Kategorien, Gruppen und Merkmale untergliedert:

« Kategoriengruppieren Fachdaten auf hochster Ebene und enthalten Gruppen. Jede Kategorie
besitzt einen Namen, eine Position und eine optionale Beschreibung.

« Gruppenfassen Merkmale von Fachdaten innerhalb einer Kategorie zusammen. Jede Gruppe
besitzt einen Namen, eine Position und eine optionale Beschreibung.

« Merkmale sind die konkreten Eigenschaften der Vorgangs-Fachdaten, z.B. ein Auftragsdatum
innerhalb einer Merkmals-Gruppe. Jedes Merkmal besitzt einen im Domain-Model eindeutigen
Namen, eine Position, eine optionale Beschreibung, einen Datentyp sowie einen optionalen
Standardwert.

Verfligbare Datentypen flir Merkmale sind:

» String: Zeichenkette

« Integer: Ganzzahl

« Decimal: FlieBkommazahl

« Boolean: Boolescher Wert

» DateTime: Datum und Uhrzeit

5.2.2  Vorgangs-Fachdaten definieren

Vorgangs-Fachdaten lassen sich sowohl fir einzelne Geschéaftsprozesse als auch flir das gesamte
Projekt bzw. mehrere Geschaftsprozesse definieren.

1. Die .bpm-Dateiin der Repository Navigator-Sicht rechtsklicken.
2. Im Kontextmeni New > Domain Model wahlen.

® « Gelten die Vorgangs-Fachdaten flir mehrere Business Processes, wird die
entsprechende .domainmodel-Datei im Repository-Ordner Activities >
DomainModel angelegt.

« Gelten die Vorgangs-Fachdaten nur flir einen bestimmten Business Process,
wird die entsprechende .domainmodel-Datei direkt unterhalb des Business
Processes angelegt. Nach dem Speichern wird diese direkt an den Start-Bauste
in des Business Processes angehangt.
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Die Datei wird nun angelegt und im X4 Designer gedffnet.

SampleDomainModel.domainmodel &3 = 0

Add.. = |Delete

Structure

Business Data Configuration | Source

3. Struktur der Fachdaten und deren Beschreibung definieren:

« Um eine neue Merkmalskategorie (Category) zu definieren, auf Add klicken oder = Add >
Category wahlen. AnschlieBend einen Namen (Name) und eine Beschreibung
(Description) eingeben.

« Um eine Merkmals-Gruppe (Group)zu definieren, innerhalb einer Kategorie
auf Add klicken oder tiber * Add > Group wéahlen. AnschlieBend einen Namen (Name)
und eine Beschreibung (Description) eingeben.

« Um ein Merkmal (Feature) zu definieren, innerhalb einer Merkmals-Gruppe
auf Add klicken oder tiber ~ Add > Feature wahlen. AnschlieBend einen Namen (Name),
eine Beschreibung (Description), den Datentyp (Type) fiir das Merkmal sowie einen
Standardwert (Default Value) eingeben.

Beispiel:
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SampleDomainModel.domainmodel 53 = 0
Add... ~ | Delete ~ v
Structure Feature
w Electronic Invoice Mame
v |nvoice Data Invaicefmount
InvoiceMumber .
. Description
InvoiceDate
InvoiceAmount
InvoiceCurrency
Invoice Sender
Invoice Receiver
Type
Decimal ~
Default Value
0,000000 =

Business Data Configuration | Source

o

« Umdie Reihenfolge eines selektierten Elements zu andern, auf ™ oder

™ Klicken.
« Uber Schaltflache Delete kdnnen Sie einen in der Baumstruktur

selektierten Eintrag I6schen.

4. Inder Symbolleiste das B—Symbol anklicken, um zu speichern.
5. .domainmodel-DateianschlieBend in den gewlinschten Business Process ziehen.

@ . domainmodel-Dateien, die unterhalb des Business Processes angelegt werden,
werden automatisch an den Start-Baustein angehangt. Die Fachdaten stehen somit
im Prozess und den enthaltenen Human Tasks zur Verfligung.

.5 Vorgangs-Statuswerte verwalten

Um Vorgange mit X4 BPM abzubilden, ist es erforderlich, die benotigten Statuswerte des Business
Processes zu definieren. Statuswerte und Statusbeschreibungen werden in einer separaten Datei(. s

tate) definiert.

5.3.1  Vorgangs-Statuswerte hinzufligen

1. Die .bpm-Dateiin der Repository Navigator-Sicht rechtsklicken.
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2. Im Kontextmeni New > Case States wahlen.

Eine neue . state-Datei wird angelegt und geoffnet.
[ InvoiceApproval.bpm &= Case.state 532 = 0

Add | | Delete

Case States State

Invoice is imported Mame
To be approved automatically
To be approved by clerk

To be approved by head of department Description
Approved
Declined
Deadline reached

Case States | Source
3. Auf Add klicken, um einen neuen Status zu definieren:

« In Name den Name des Status eingeben, z.B. Approved.
- In Description eine zugehorige Beschreibung eingeben (optional).

4. Umdie Reihenfolge eines selektierten Statuswerts zu andern, auf | oder ™ Klicken.
5. Datei speichern.

® Uber Schaltflache Delete konnen Sie einen selektierten Statuswert I6schen.

o Vorgangs-Status mit Intermediate Events setzen
Den Status eines Vorgangs, der zur Laufzeit des aktuellen Business Processes bearbeitet
werden soll, konnen Sie auch mit Intermediate Events setzen. Hierzu stehen in
Eigenschaft Case Management > Case State desIntermediate Events alle prozessweit
definierten Vorgangs-Statuswerte zur Auswahl.

b.4  Task Management Web App

Uber Human Tasks lassen sich Menschen in Business Processes einbinden. Die Task Management
Web App bietet die entsprechende Oberflache zur Abarbeitung der definierten Aufgaben.

Die Task ManagementWeb App besitzt bereits eine vordefinierte Struktur und vordefinierte
Funktionen. Innerhalb des entsprechenden Business Process und Uber verschiedene Einstellungen
im Human Task Editorlassen sich jedoch weitere Einstellungen vornehmen.
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® Die Task Management Web App lasst sich GUber das Meni Tools > X4 Task
Management 6ffnen. Die Standard-Zugangsdaten sind demo/demo.

@ X4 Task Management

Benutzername

Angemeldet bleiben

Passwort vergessen?

5.4.1 Fachdaten definieren und anzeigen

Fachdaten werden tber die Eigenschaft Business Data des Business Processes definiert, siehe
Vorgangs-Fachdaten verwalten. Welche der definierten Fachdaten flir den Benutzer in der Task
Management Web App tatsachlich angezeigt werden, wird Gber den Human Task Editor, innerhalb der
Registerkarte Business Data angegeben.
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@ Business Data Configuration

qqqqq

Fechnungedsim
30.11.2009, 00:00:00

[ o e i ikin it 7

2 SendierNeme.
(2 SenderVatld
v [ Sender Address
(9 Sendier Address Sureet
(50 Sender Address Zip Code
[ Sender Address Town
20 Sendier Address Country Code.
v [ Invoice Receiver
< [ Receiver nformation
(0] Receiver Name
[ Recei

16
v [ Receiver Address
0 Receiver Address Strect

] Recelver Address Zip Code

0] Receiver Address Town

0] Receiver Address Country Code

5.4.2 Status definieren und setzen

Statuswerte werden Gber die Eigenschaft Case States des Business Processes definiert, siehe
Vorgangs-Statuswerte verwalten. Welche der definierten Status ein Benutzer in der Task
Management Web App flr seine Vorgange tatsachlich setzen kann, wird Gber den Human Task Editor,
innerhalb der Registerkarte Actions angegeben.

@ Casetate Confgurtion

oee]
Case States.
rvoceispored

To be approved automatically
To be approved by clerk

To be approved by head of department
Approved

Declined
Deadline reached
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5.4.3  Vorgange ablehnen, weiterleiten und auf Wiedervorlage setzen

Ob der Bearbeiter die Mdglichkeit haben soll, Vorgédnge abzulehnen, weiterzuleiten oder auf
Wiedervorlage zu setzen, kann im Human Task Editor, innerhalb der Registerkarte Settings definiert
werden.

@ X4 Task Management & Hallo, Carolne Clerk :

Falligkeitsdatum

Bitte geben Sie die Rechnung fre oder hnen e sie gegebenenfalls ab

inTask Web App) Allgemein Rechnungssteller Dokumente
Rechnungskopfdaten

RANR-2018-001 30.11.2009, 00:00:00 9000 EUR

][22 Creste | [ M Deleic] [[(= 0pen

b.4.4  Dokumente anzeigen und bearbeiten

Ob Dokumente in der Task ManagementWeb App angezeigt und ggf. bearbeitet werden sollen, wird
im Human Task Editor, innerhalb der Registerkarte Settings definiert.

« MitEnable Documents werden die Registerkarte Dokumente sowie die Schaltflache
Herunterladen in der Task Management Web App eingeblendet.

« Uber Documents can be added/edited kdnnen Dokumente bearbeitet (Schaltfliche
Hochladen) und hinzugefiigt (Schaltflache Neues Dokument) werden.

© SoftProject GmbH 97



X4 BPM

Documents
[ Enable Documents.

[ Documents can be added/edited
2 Documents can be deleted

5.4.5  Falligkeitsmanagement flr Vorgangen

Fir jeden Vorgang kann eine Falligkeit definiert werden. Diese wird innerhalb des Human Task
Editorsunter General > Deadline angegeben. Neben einer Frist (Duration) kann auch eine genaue
Falligkeit (Unt+i1) mit Datum und Uhrzeit definiert werden. Zudem kann (iber Case State ein Status
angegeben werden, der automatisch ausgefihrt wird, wenn die Frist des Vorgangs erreicht wurde.

Deadline
) No deadline

@Duration [0 [3] Days[8 [2] Hours [0 [3] Minutes

Ountil [16082019 @~ | [13:40:11/3]]

CaseState  Declined
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Ist die Falligkeit des Vorgangs eingetreten, bevor er bearbeitet werden konnte und der Prozess wurde
automatisch mit einem konfigurierten Case State fortgesetzt, wird der Vorgang automatisch
geschlossen und innerhalb der Task Management Web App in den Ordner Verfallen verschoben. Hier
werden alle Vorgadnge angezeigt, die die Frist Gberschritten haben und automatisch geschlossen
wurden.

e X4 Task Management & Hallo, Caroline Clrk
g o

Filligkeitsdatum

/" InBearheitung

A viedervorlage RNR-2018-001 Rechnungsfreigabe 31.8.2020 15:02:03 Perstnlich 31.8.2020 15:01:03

Erledigt

© Verfallen
Bitte geben Sie die Rechnung frel oder lehnen Sie sie gegebenenfalls ab

Allgemein Rechnungssteller Dokumente

Rechnungskopfdaten

RNR-2018-001 30.11.2009, 00:00:00 4668 EUR

Um Vorgange mit einer Deadline besser hervorzuheben, werden diese in der Task Management Web
App farblich gekennzeichnet:

. M Die Falligkeit des Vorgangs wurde Uberschritten und der Vorgang wurde automatisch
geschlossen und in den Ordner Verfallen verschoben.

- M per Vorgang ist noch am selben Tag fallig.

. : Die Falligkeitsdauer zur Abarbeitung des Vorgangs ist > 24 Stunden.
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@ X4 Task Management 2 balo, e et |

.

In Bearbeitung

Falligkeitsdatum Zuwelsung

A Wiedervorlage

Erledigt

@ Verfallen

RNR-2018-002 Rechnungsfreigabe Persdnlich i 17.6.2020 12:52:30

Bitte geben Sie die Rechnung frei oder lshnen Sie sie gegebenenfalls ab
Allgemein Rechnungsstelle Dokumente

Rechnungskopfdaten
echnunasnummer echnungsdatum echnungsbetrag Nahrung
A

RNR-2018-002 30.11.2009 00 ¢ : 00 y 6666 EUR

5.4.6  Aufgabenin der Task Management Web App bearbeiten

Flr Vorgange, die einem Prozessbeteiligten zugewiesen wurden, gibt es verschiedene
Bearbeitungsmoglichkeiten. Diese werden im Folgenden naher erlautert.

5.4.6.1 Vorgang bearbeiten

Nach dem Einloggen in der Task Management Web App werden zunachst alle offenen Vorgange in
einer Ubersicht angezeigt. Durch Auswahlen eines Vorgangs in der Vorgangsliste werden dessen
Details Uber mehrere Registerkarten angezeigt.
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@ X4 Task Management

2 Hallo, Caroline Clerk

len -

/" InBearbeitung

Félligkeitsdatum Zuweisung

A Wiedervorlage

Erledigt RNR-2018-001 Rechnungsfreigabe 31.8.2020 15:02:03 Personlich 31.8.2020 15:01:03

@ Verfallen

Bitte geben Sie die Rechnung frei oder lehnen Sie sie gegebenenfalls ab

Allgemein Rechnungssteller Dokumente

Rechnungskopfdaten

RNR-2018-001 30.11.2009, 00:00:00 8888 EUR

Um einen Vorgang zu bearbeiten, gehen Sie wie folgt vor:

1. Den zu bearbeitenden Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen)
auswahlen.
2. Bearbeiten klicken.
3. Gewunschte Bearbeitungsmaglichkeit wahlen:
» Freigeben: Vorgang freigeben
« Ablehnen: Vorgang ablehnen
« Herunterladen: Dokument herunterladen
» Hochladen: Dokument hochladen und vorhandenes Dokument ersetzen
« Dokument 18schen: Dokument |6schen
« Neues Dokument: Neues Dokument hochladen

5.4.6.2 Vorgang freigeben

Um einen Vorgang freizugeben, gehen Sie wie folgt vor:

1. Gewliinschten Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen) auswéhlen.
2. Bearbeiten klicken, um die Bearbeitungssicht zu 6ffnen.
3. Freigeben klicken.

Der Vorgang wird nun in den Ordner Erledigt verschoben.

5.4.6.3 Vorgangablehnen

Um einen Vorgang abzulehnen, gehen Sie wie folgt vor:

1. Gewliinschten Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen) auswéhlen.
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2. Ablehnen klicken.

@ Alternativ I3sst sich der Vorgang auch in der Bearbeitungssicht ablehnen. Hierzu
zunachst Bearbeiten und anschlieBend Ablehnen klicken.

Der Vorgang wird an den Vorgangsbesitzer (Owner) zurlickgesendet.

5.4.6.4 Vorgang weiterleiten
Um einen Vorgang weiterzuleiten, gehen Sie wie folgt vor:
1. Gewiinschten Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen) auswahlen.

2. Weiterleiten klicken.
Folgender Dialog wird gedffnet:

Aufgabe weiterleiten

Zuweisung

Wahlen Sie bitte Zuweisungsart aus.

O Personlich

(O Team

= EX
3. Zuweisungsart angeben:

« Personlich: Der Vorgang wird an einen einzelnen Benutzer weitergeleitet
« Team: Der Vorgang wird an eine Gruppe weitergeleitet
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4. Weiter klicken.
Folgender Dialog wird gedffnet:

Aufgabe weiterleiten

Zuweisung

admin -

Falligkeitsdatum

[ Falligkeitsdatum

Kommentar (optional)

5. Details zur Weiterleitung angeben:

« Unter Zuweisung den entsprechenden Benutzer oder die Gruppe
« Unter Falligkeitsdatum bei Bedarf die Falligkeit des Vorgangs

Dazu die Checkbox aktivieren und ein Datum sowie eine Uhrzeit wahlen. Mit ¥ die
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Angaben bestatigen.

Aufgabe weiterleiten

Zuweisung

admin

Falligkeitsdatum
SEP. 2020 ~ < >

Falligkeitsdatum

Kommentar (optional) SEF

@
(=]
[N ]
.
o
=}

-
=5
o
o
ot
e}
w

14 15 16 17 18 19 20

28 29 30 |
et P
s
e W
v

» Bei Bedarf einen Kommentar angeben.

6. Weiterleiten klicken.
Der Vorgang wurde an den angegebenen Benutzer bzw. an die angegebene Gruppe

weitergeleitet.

5.4.6.5 Vorgangund auf Wiedervorlage setzen

Um einen Vorgang auf Wiedervorlage zu setzen, gehen Sie wie folgt vor:

1. Gewiinschten Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen) auswahlen.
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2. Wiedervorlage klicken.
Folgender Dialog wird gedffnet:

Wiedervorlage anlegen

Bitte geben Sie ein Datum zur Wiedervorlage ein: ol

Kommentar (optional)

x

3. Gewlnschtes Datum sowie eine Uhrzeit angeben. Mit ¥  die Angaben bestatigen.
Bei Bedarf einen Kommentar angeben.
5. OKklicken.

Der Vorgang wird nunin den Ordner Wiedervorlage verschoben.

=

5.4.6.6  Dokumente anzeigen und bearbeiten

Um die angehdngten Dokumente zu einem Vorgang zu bearbeiten, gehen Sie wie folgt vor:

1. Den zu bearbeitenden Vorgang in der Vorgangsliste der Ubersichtsseite (Ordner 0f fen)
auswahlen.

® Wenn sich der Vorgang bereits in Bearbeitung befindet, den entsprechenden Vorgang
im Ordner In Bearbeitungauswahlen.

2. Bearbeiten klicken.
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3.

Innerhalb der Vorgangsdetails die Registerkarte Dokumente 6ffnen.

Abbrechen B Speichern Freigeben Ablehnen ﬁ Herunterladen Hochladen i Dokument lschen Neues Dokument
In Bearbeitung

Filligkeitsdatum Zuweisung

RNR-2018-001 Rechnungsfreigabe 31.8.2020 15:02:03 Persénlich 31.8.202015:01:03

Bitte geben Sie die Rechnung frei oder ehnen Sie sie gegebenenfalls ab

Allgemein Rechnungssteller Dokumente

Dateiname Bearbeitet am

Die verschiedenen Bearbeitungsoptionen werden nun als Buttons angezeigt:
« MitHerunterladen das Dokument herunterladen.
« MitHochladen ein neues Dokument aus dem Dateisystem hochladen und das
vorhandene Dokument ersetzen.
« Mit Dokument 16schen das Dokument unwiderruflich I6schen.

& Das Lischen eines Dokumentes kann nicht mehr rickgangig gemacht werden.
Loschen Sie Dokumente nur wenn Sie sicher sind, dass Sie sie nicht mehr
bendtigen.
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« Mit Neues Dokument ein neues Dokument hochladen. Dazu im Dialog Neues Dokument
einen Title angeben und mit Hochladen ein Dokument aus dem Dateisystem auswahlen.

X

Bitte geben Sie den Titel fiir das Dokument an

Hochladen
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6 Scheduler

Die Scheduler-Oberflache bietet einen Uberblick tiber sdmtliche Prozesse, fiir die eine zeitgesteuerte
Ausflihrung definiert wurde. Zudem bietet die Oberflache auch die Méglichkeit, neue zeitgesteuerte
Ausfihrungen zu konfigurieren sowie bereits bestehende Konfigurationen zu bearbeiten oder zu
|0schen.

Bei der Definition von Schedules wird zwischen folgenden Ausflihrungsoptionen unterschieden:

« Serverstart: Ausflihrung eines Prozesses beim Serverstart
« CRON: Ausflihrung eines Prozesses nach bestimmten Cron-Mustern

Die wichtigsten Funktionen des Schedulers sind:

. Ubersicht der bestehenden Schedules
- Erstellen/Bearbeiten von beliebig vielen Ausfiihrungspunkten und -intervallen pro Prozess

6.1 Scheduler erstellen

a

« Der Scheduler kann nur in BPM- und ESB-Projekten erstellt werden.
« Ineinem Projekt kann nur ein Scheduler erstellt werden.

1. In der Repository Navigator Sicht ein Projekt rechtsklicken.
2. Im Kontextmenl New> Schedule wahlen.

[P Repository Navigator &3 & = O
X4 Server (Default) v Q-
Filter
w [ BPMProject

I Mew » Process Landscape...
|
5 Copy Full Path to Clipboard t} Webservice Include...

Copy X5tore URL to Clipboard Schedule...

£+ Refresh

Der Scheduler wird erstellt und ge6ffnet.

@ \Weitere Informationen finden Sie im Abschnitt

» Prozesse zeitgesteuert ausfiihren

6.2 Prozesse zeitgesteuert ausfihren

Bei der zeitgesteuerten Ausfiuhrung von X4-Prozessen konnen folgende Ausfiihrungsoptionen
unterschieden werden:
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« Ausflihrung eines Prozesses beim Serverstart
« Ausfihrung eines Prozesses nach bestimmten Cron-Mustern

Mit Cron-Muster kdnnen Sie Prozesse an bestimmten Tagen zu bestimmten Uhrzeiten ausfihren, z. B.
jeden Freitag, um 12 Uhr.

6.2.1 Neue zeitgesteuerte Ausfihrung anlegen

Um eine zeitgesteuerte Ausfihrung anzulegen, gehen Sie wie folgt vor:

1. Im Scheduler . schedule die gewlnschte Ausflihrungsoption klicken.
a. Cron, um Prozesse nach bestimmten Cron-Mustern auszufihren.
b. Startup, um Prozesse beim Serverstart auszufihren.

2. Gewlnschte Konfiguration vornehmen.

@ Firdie Konfigurationsmaglichkeiten der verschiedenen Ausfihrungstypen, siehe:
« Serverstart
« Cron

3. Speichern klicken, um die Ausfliihrung zu speichern.

@ Die Dokumentation der ReST-Schnittstelle finden Sie unter http://localhost:8080/X4/X4Api/.

6.2.2 Serverstart

Neue Konfigurationen fir Ausfihrungen beim Serverstart konnen tber die Schaltflache
Startup angelegt werden. Dabei stehen eine Reihe von Optionen und Parameter zur Verfligung. Diese
werden im Folgenden naher erlautert.

Optionen
Name Frei wahlbarer Name fir die Ausflihrung
Process Pfad zum Prozess in der X4DB
Beispiel: Processes/Activities/Processes/Process.wrf
Browse... klicken, um einen Prozess zu wahlen.
a Der Prozess muss sich im selben Projekt wie der
)
Scheduler befinden.
» Der Prozess darf kein Unterprozess eines weiteren
Prozesses sein.
Active Aktiviert den Scheduler
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Start date

End date

Parameter

Setzt den Startzeitpunkt des Schedulers im Format jjjj-mm-tt
hh:mm:ss

Beispiel:2021-06-01 13:00:00

Setzt den Endzeitpunkt des Schedulersim Format jjjj-mm-tt
hh:mm:ss

Beispiel: 2022-08-01 23:00:00

@ Der Endzeitpunkt muss in der Zukunft liegen.

Im Bereich Parameter konnen Sie beliebig viele Parameter zur Ausfihrkonfiguration definieren.

|

Ke
Value

<

6.2.3

Zeile hinzufligen

Zeile 16schen

Name des Parameters (beliebige Zeichenkette, idealerweise NCName)

Optionaler Parameterwert

Neue Konfigurationen fir Ausfihrungen beim Serverstart kdnnen Gber die Schaltflache

Cron angelegt werden. Dabei stehen eine Reihe von Optionen und Parameter zur Verfliigung. Diese

werden im Folgenden naher erlautert.

Optionen

Name
Process

Active

Frei wahlbarer Name fur die Ausfihrung
Pfad zum Prozess in der X4DB

Beispiel- Processes/Activities/Processes/Process.wrf

Browse... klicken oder einen Prozess per Drag & Drop in das Feld
ziehen, um einen Prozess zu wahlen.

& . DerProzess muss sich im selben Projekt wie der
Scheduler befinden.
» Der Prozess darf kein Unterprozess eines weiteren
Prozesses sein.

Aktiviert den Scheduler
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Generate Cron Expression  Erzeugt einen Cron-Ausdruck

Mdgliche Werte:

* Minutes
* Hourly
» Daily

* Weekly
* Monthly
* Yearly

® InderRegisterkarte Source kdnnen Sie den Cron-Ausdruck
manuell editieren.

Das Generieren eines Cron-Ausdrucks ist nicht moglich, wenn
der Cron-Ausdruck manuell editiert wurde.

Parameter

Im Bereich Parameter konnen Sie beliebig viele Parameter zur Ausfihrkonfiguration definieren.

Zeile hinzufligen

|

= Zeile 16schen
Key Name des Parameters (beliebige Zeichenkette, idealerweise NCName)
Value Optionaler Parameterwert
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7 Profiling

In einer Datei flr das Monitoring von Profiling-Daten (. profiling) konnen Sie festlegen, ob Prozesse
innerhalb Ihres Projekts zur Laufzeit protokolliert werden sollen. In dieser Datei kdnnen Sie dabei
genau definieren, welche Prozesse von der Protokollierung erfasst oder ausgeschlossen werden.

Die .profiling-Datei muss nurangelegt werden, wenn Sie bestimmte Prozesse von der
Protokollierung ausschlieBen wollen.

So legen Sie eine Datei fiir das Monitoring von Profiling-Daten an

1. Klicken Sie in der Sicht Projects mit der rechten Maustaste auf ein Projekt.
2. Wahlen Sie im Kontextmen(i New > Monitoring.
Die Monitoring-Konfigurationsdatei wird erstellt und ge6ffnet.

® Hinweis:
In einem Projekt kann nur eine . profiling-Datei erstellt werden.

Sie kdnnen das Monitoring von Profiling-Daten (. profiling-Datei)in der Design-Ansicht und in der
Source-Ansicht konfigurieren. Beide Moglichkeiten werden auf den folgenden Seiten beschrieben.
Zum Aufrufen der gewlinschten Ansicht klicken Sie am unteren Rand einer .profiling-Dateiauf De
sign oder Source.

@ Weitere Informationen:

« Monitoring von Profiling-Daten in der Design-Ansicht konfigurieren
« Monitoring von Profiling-Daten in der Source-Ansicht konfigurieren
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